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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer
“Documentation” means information published by Avaya in varying
mediums which may include product information, operating
instructions and performance specifications that Avaya may generally
make available to users of its products and Hosted Services.
Documentation does not include marketing materials. Avaya shall not
be responsible for any modifications, additions, or deletions to the
original published version of documentation unless such
modifications, additions, or deletions were performed by Avaya. End
User agrees to indemnify and hold harmless Avaya, Avaya's agents,
servants and employees against all claims, lawsuits, demands and
judgments arising out of, or in connection with, subsequent
modifications, additions or deletions to this documentation, to the
extent made by End User.

Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: http://support.avaya.com or such successor site as
designated by Avaya. Please note that if You acquired the product(s)
from an authorized Avaya Channel Partner outside of the United
States and Canada, the warranty is provided to You by said Avaya
Channel Partner and not by Avaya.

Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTP://SUPPORT.AVAYA.COM/LICENSEINFO OR
SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, ARE
APPLICABLE TO ANYONE WHO DOWNLOADS, USES AND/OR
INSTALLS AVAYA SOFTWARE, PURCHASED FROM AVAYA INC.,
ANY AVAYA AFFILIATE, OR AN AVAYA CHANNEL PARTNER (AS
APPLICABLE) UNDER A COMMERCIAL AGREEMENT WITH
AVAYA OR AN AVAYA CHANNEL PARTNER. UNLESS
OTHERWISE AGREED TO BY AVAYA IN WRITING, AVAYA DOES
NOT EXTEND THIS LICENSE IF THE SOFTWARE WAS
OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License. The

applicable number of licenses and units of capacity for which the
license is granted will be one (1), unless a different number of
licenses or units of capacity is specified in the documentation or other
materials available to You. “Software” means computer programs in
object code, provided by Avaya or an Avaya Channel Partner,
whether as stand-alone products, pre-installed on hardware products,
and any upgrades, updates, patches, bug fixes, or modified versions
thereto. “Designated Processor” means a single stand-alone
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Copyright
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company's behalf). Be aware that there can be a risk of Toll Fraud
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result in substantial additional charges for your telecommunications
services.

Avaya Toll Fraud intervention
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Chapter 1: Introduction

This document describes how to deploy, commission, and test Avaya Contact Center Select
Release 6.4 using a DVD or ISO image. An ISO image is an archive file of a DVD disc, a type of
disk image composed of the data contents of every written sector of an optical disc, including the
optical disc file system.

Purpose
This document describes the product or solution architecture, suggested topologies, capacities, and
interoperability. This document also describes the features and functional limitations of certain
configurations. With this information, sales design specialists can make decisions about designs that
meet the business needs of a customer.

Intended audience
This document is intended for personnel who determine the best design to meet the business needs
of a customer.

Related resources
The following are some additional Avaya Contact Center Select related resources.

Documentation
The following table lists some of the documents related to Avaya Contact Center Select. Download
the documents from the Avaya Support website at http://support.avaya.com.
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Category Title Description Audience
Overview Avaya Contact Center

Select Solution Description
This document provides a
technical description of Avaya
Contact Center Select. It
describes the product features,
specifications, licensing, and
interoperability with other
supported products.

This document is
intended for
personnel who
determine the best
design to meet the
business needs of a
customer.

Deployment Deploying Avaya Contact
Center Select DVD

This document contains
information about Avaya
Contact Center Select DVD
installation, initial
configuration, and verification.
This document contains
information about maintaining
and troubleshooting the Avaya
Contact Center Select server.

This document is
intended for
personnel who
deploy, commission,
and test the Avaya
Contact Center Select
DVD.

Deployment Deploying Avaya Contact
Center Select Software
Appliance

This document contains
information about Avaya
Contact Center Select
Software Appliance (VMware
OVA) preparation, deployment,
initial configuration, and
verification. This document
contains information about
maintaining and
troubleshooting the software
appliance.

This document is
intended for
personnel who
deploy, commission,
and test the Avaya
Contact Center Select
software appliance.

Deployment Deploying Avaya Contact
Center Select Hardware
Appliance

This document contains
information about Avaya
Contact Center Select
Hardware Appliance (physical
server) installation, initial
configuration, and verification.
This document contains
information about maintaining
and troubleshooting the
hardware appliance.

This document is
intended for
personnel who
deploy, commission,
and test the Avaya
Contact Center Select
hardware appliance.

Deployment Avaya Contact Center
Select Business Continuity

This document contains
information about Avaya
Contact Center Select
Business Continuity.

This document is
intended for
personnel who
deploy, commission,
and test Avaya
Contact Center Select
Business Continuity.

Administration Administering Avaya
Contact Center Select

This document contains
information and procedures to
configure the users, skillsets,
and contact center

This document is
intended for
personnel who
perform the day-to-

Introduction
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Category Title Description Audience
configuration data. This
document contains information
about creating Avaya Contact
Center Select real-time
displays and historical reports.

day administration of
Avaya Contact Center
Select.

Administration Avaya Contact Center
Select Advanced
Administration

This document contains
information about managing
Avaya Contact Center Select
licensing and multimedia
configuration.

This document is
intended for
personnel who
manage Avaya
Contact Center
Select.

Administration Upgrading and patching
Avaya Contact Center
Select

This document contains
information about upgrading
and patching Avaya Contact
Center Select.

This document is
intended for
personnel who
maintain Avaya
Contact Center
Select.

User guide Avaya Contact Center
Select Agent Desktop Guide

This document contains
information about using Agent
Desktop.

This document is
intended for Avaya
Contact Center Select
Agents and Agent
Supervisors.

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot Avaya
products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Procedure
• To find videos on the Avaya Support website, go to http://support.avaya.com and perform one

of the following actions:

- In Search, type Avaya Mentor Videos to see a list of the available videos.
- In Search, type the product name. On the Search Results page, select Video in the

Content Type column on the left.
• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and

perform one of the following actions:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click the name of a topic to see the available list of videos posted
on the website.

Related resources
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Note:

Videos are not available for all products.

Support
Go to the Avaya Support website at http://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Introduction
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Chapter 2: Overview

The Avaya Contact Center Select DVD software provides a context-sensitive, collaborative, voice
and multimedia customer experience solution that allows small to midsize enterprises to anticipate,
accelerate, and enhance customer interactions. Avaya Contact Center Select uses the Avaya IP
Office telephone system to provide a real-time telephony platform. Avaya IP Office is a flexible and
scalable phone system designed specifically for small and midsize enterprises. IP Office supports a
wide range of phones and devices for use in contact centers.

The Avaya Contact Center Select DVD deployment option supports Platform Vendor Independence
(PVI). This provides the flexibility to purchase a server that meets the PVI server specification and
conforms with your corporate standards. To use the Avaya Contact Center Select DVD deployment
option, the customer must provide the following:

• Server hardware that meets the Avaya Contact Center Select Platform Vendor Independence
(PVI) specification.

• Microsoft Windows 2008 Release 2 Service Pack 1 64–bit Standard Edition or Enterprise
Edition operating system and license.

The following diagram shows the topology of a typical Avaya Contact Center Select solution:
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Avaya Contact Center Select is preloaded with sample users, skillsets, and contact center
parameters. You can use this sample data to rapidly commission the solution and make the first
routed call and email contact. Avaya Contact Center Select delivers quick and simplified contact
center deployment. After the basic telephony features are working, you can then configure
multimedia contacts, multiplicity, custom prompts, other enhanced features and functions to improve
your customer’s experience.

To deploy Avaya Contact Center Select software using the DVD software, perform the following:

• Obtain a server that meets the Avaya Contact Center Select PVI requirements.

• Configure the server and format the hard disk partitions to the required specifications.

• Install the Microsoft Windows 2008 Release 2 Service Pack 1 64–bit Standard Edition or
Enterprise Edition operating system.

• License and activate the Microsoft Windows 2008 operating system.

• Add the Avaya Contact Center Select server to a workgroup or a Windows domain.

• Obtain an Avaya Contact Center Select DVD and license.

• Use the Avaya Contact Center Select DVD to install the software components and applications.

• Use the Avaya Contact Center Select configuration Ignition Wizard to rapidly deploy a
functional contact center solution.

The Avaya Contact Center Select DVD contains the following software components:

• Contact Center Manager Server (CCMS)

Overview
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• Contact Center Manager Administration (CCMA)

• Communication Control Toolkit (CCT)

• Contact Center License Manager (LM)

• Contact Center Manager Server Utility (SU)

• Orchestration Designer (OD)

• Contact Center Multimedia (CCMM)

• Avaya Media Server (Avaya MS)

• Contact Center Services for Avaya Media Server

• Avaya Contact Center Select Firewall policy

• Default Avaya Contact Center Select configuration data

• An Ignition Wizard configuration utility

The Avaya Contact Center Select server is supported in a workgroup or in a Windows domain. After
you deploy Avaya Contact Center Select, you can add the server to a Windows domain. For more
information about adding the Avaya Contact Center Select server to a Windows domain, see Adding
the server to a domain on page 91.

Note:

The Avaya Contact Center Select DVD deployment option does not support VMware. For
information about Avaya Contact Center Select and VMware, see Deploying Avaya Contact
Center Select Software Appliance.
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Chapter 3: Deployment process

This work flow shows the sequence of tasks you perform to deploy Avaya Contact Center Select.
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Chapter 4: Installation checklist

The following sections list the main Avaya IP Office and Avaya Contact Center Select configuration
and deployment details. You must know these configuration details before you can deploy and
commission an Avaya Contact Center Select solution.

Planning tasks
• Read Avaya Contact Center Select Solution Description.
• Ensure that the server hardware meets the Avaya Contact Center Select PVI specification for

your agent count and call rate.

Complete the following checklists before continuing.

Avaya IP Office configuration checklist
The following table lists and describes the configuration details required by IP Office.

Configuration Item Your value Description
IP Office Server type Is the IP Office a Server Edition server.
Server release The IP Office software release.
IP address The IP address of the IP Office server.
IP Office System Password In IP Office Manager, select File > Advanced >

Security Settings. Select System and then select
the Unsecured Interfaces tab. The IP Office
System Password is configured here.

IP Office Manager IP
address

The IP address of the client computer with IP
Office Manager software.

IP Office Manager user
name

The user name used to log on to IP Office
Manager.

IP Office Manager
password

The password used to log on to IP Office Manager.

Avaya Contact Center
Select IP address

The IP address of the Avaya Contact Center Select
server.

Avaya Contact Center
Select username

The name of the Avaya Contact Center Select data
synchronization user account. The default user
name is accssync.
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Configuration Item Your value Description
Avaya Contact Center
Select password

The password of the Avaya Contact Center Select
data synchronization user account. The default
password is accssync.

SIP domain name The name of the SIP domain used by IP Office.
SIP User Extension
Number

The IP Office SIP User Extension Number used by
Avaya Contact Center Select to register for CTI call
control and SIP session messaging.

SIP User Extension
Password

A password for the IP Office SIP User Extension
Number. The password must be a number.

SIP User Login Code

[User > Telephony >
Supervisor Settings > Login
Code ]

The IP Office SIP User Telephony Supervisor
Login Code used by Avaya Contact Center Select
to register for CTI call control and SIP session
messaging. The Login Code must be a number.

Short Code – Code number A solution short code to map an IP Office
telephone number to the Avaya Contact Center
Select SIP User Extension Number.

Short Code - Telephone
Number

A short code telephone number that outputs to an
Avaya Contact Center Select CDN (Route Point).

Agent extensions The IP Office Extensions to be used by Avaya
Contact Center Select users.

Avaya Contact Center Select DVD checklist
The following table lists and describes the configuration details required by the Avaya Contact
Center Select DVD. The email related configuration items are optional.

Configuration Item Your value Description
MAC address of Avaya
Contact Center Select
server

You use this unique MAC address to obtain a
Contact Center WebLM license from the Avaya
Product Licensing and Delivery System (PLDS).

License file A license file for Avaya Contact Center Select.
Server hostname The host name of the Avaya Contact Center Select

server.

Server names must adhere to RFC1123. For more
information, see Avaya Contact Center Select
Solution Description.

Avaya recommends that you configure the server
final production name before installing Avaya
Contact Center Select.

Server IP address The IP address of the Avaya Contact Center Select
server.

Installation checklist
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Configuration Item Your value Description
Server mask The network mask of the Avaya Contact Center

Select server.
Server default gateway The default gateway used by the Avaya Contact

Center Select server.
DNS server IP address The IP address of the DNS server used by Avaya

Contact Center Select.
Country or region The Microsoft Windows Server 2008 country or

region server setting.
Time and currency The Microsoft Windows Server 2008 time and

currency server setting.
Keyboard layout The Microsoft Windows Server 2008 keyboard

layout server setting.
Microsoft Windows Server
2008 R2 SP1 Standard
Edition or Enterprise
Edition product key

The Microsoft Windows Server 2008 R2 SP1
Standard Edition or Enterprise Edition product key
used to activate the Operating System.

Administrator password A password for the Avaya Contact Center Select
Administrator account.

IP Office Server - IP
Address

The IP address of the IP Office server.

IP Office Server - Voice
Port

The number of the voice port used to communicate
with IP Office. The default port number is 5060.

IP Office SIP Domain
Name

The name of the SIP Domain used by IP Office.

IP Office SIP Extension -
Extension Number

The IP Office SIP User Extension Number used by
Avaya Contact Center Select to register for CTI call
control and SIP session messaging.

IP Office SIP Extension -
Password

The IP Office SIP User Telephony Supervisor
Login Code used by Avaya Contact Center Select
to register for CTI call control and SIP session
messaging.

IP Office Service User -
Username

The Service User Name of the IP Office Manager
for your IP Office call server.

IP Office Service User -
Password

The Service User Password of the IP Office
Manager for your IP Office server.

IP Office System Password The System Password for the IP Office server.

In IP Office Manager, select File > Advanced >
Security Settings. Select System and then select
the Unsecured Interfaces tab. The IP Office
System Password is configured here.

Sample agent IDs The phone number of the first IP Office sample
user.

Avaya Contact Center Select DVD checklist
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Configuration Item Your value Description
Sample CDN (Route Point) The phone number of the IP Office short code

Telephone Number.
Avaya Media Server Locale The language and country locale used by Avaya

Media Server.
System Account
Configuration Password.

A password for the Avaya Contact Center Select
administration account.

Mailbox Display Name The display name of the Avaya Contact Center
Select mailbox.

Mailbox email address The email address of the Avaya Contact Center
Select mailbox.

Mailbox email password The password for the Avaya Contact Center Select
mailbox.

Incoming Mail Server host
name

The name of the server on which email messages
are received in your network.

Incoming Mail Server
protocol

The communication protocol for the inbound email
server.

Incoming Mail Server
encryption type

The encryption type used by the inbound email
server.

Incoming Mail Server port
number

The port number used by the inbound email server.

Outgoing Mail Server host
name

The name of the server from which email
messages are sent. Your inbound and outbound
mail servers can have the same name.

Outgoing Mail Server
protocol type

The communication protocol for the outbound
email server.

Outgoing Mail Server
encryption type

The encryption type used by the outbound email
server.

Outgoing Mail Server port
number

The port number used by the outbound email
server.

Outgoing Mail Server
SMTP Authentication type

The authentication type used by the outbound
email server.

Installation checklist

18     Deploying Avaya Contact Center Select DVD December 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Contact Center Select DVD


Part 1: IP Office configuration

Chapter 5: IP Office configuration

Configure IP Office to integrate with Avaya Contact Center Select. This section does not describe IP
Office basic configuration for system settings, licensing, or networking. This section describes only
how to integrate a working IP Office server with Avaya Contact Center Select.

The procedures in this section use examples to describe how to configure IP Office to integrate with
Avaya Contact Center Select. The IP Office configuration values used in the following procedures
match the default values used by Avaya Contact Center Select. These values might not be suitable
for your solution. If you use different IP Office configuration values, remember to enter the different
values when installing and commissioning Avaya Contact Center Select.

Avaya recommends that you configure IP Office before installing Avaya Contact Center Select.

You must complete the procedures in this IP Office section in sequential order.

IP Office supported versions
Each Avaya Contact Center Select connects to a single IP Office Server Edition Primary server.
Avaya Contact Center Select Business Continuity-enabled solutions support connecting to an IP
Office Secondary server. A Small Community Network (SCN) is a system of networked IP Office
telephone systems that can share extension numbers and user names. Each IP Office SCN
supports a single connected Avaya Contact Center Select. The Avaya Contact Center Select server
and the connected IP Office server must be located at the same campus location.

To support an IP Office SCN, Avaya Contact Center Select must connect to an IP Office Server
Edition Primary server in that SCN network.

Avaya Contact Center Select supports only the following versions of IP Office:

• IP Office Server Edition Release 9.0.3, 9.0.4, and Release 9.1.

• IP Office 500V2, Release 9.0.3, 9.0.4, and Release 9.1 software, Standard Mode, Advanced
Edition license

Avaya Contact Center Select does not support other versions of IP Office.
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Avaya Contact Center Select does not support IP Office 500V2 Basic mode.

Avaya Contact Center Select Business Continuity is supported only with IP Office Server Edition
Release 9.1. For more information, see Avaya Contact Center Select Business Continuity.

Avaya Contact Center Select supports TLS communication with IP Office Server Edition Release
9.1. For more information about configuring TLS security certificates, see Avaya Contact Center
Select Advanced Administration.

Using IP Office Manager
Before you begin

• Install the IP Office Manager software on a client computer.
• Ensure the client computer can communicate with the IP Office server.

About this task
IP Office Manager is a component of the IP Office administration suite of applications. You use IP
Office Manager to configure IP Office. IP Office Manager runs on a Windows computer and
connects to the IP Office system using an Ethernet LAN connection.

IP Office Manager is an off-line editor. Use IP Office Manager to connect to your IP Office server
and retrieve a local copy of the IP Office current configuration settings. You can then edit the local
copy of the IP Office configuration and when you are ready, save your updated configuration data
back to the IP Office server.

Procedure
1. On the client computer, select Start > All Programs  > IP Office  > Manager.

2. On the Configuration Service User Login message box, in the Service User Name box,
type the user name. The default name is Administrator.

3. In the Service User Password box, type the user password. The default password is
Administrator.

4. From the menu, select File  > Close Configuration. This closes any open and potentially
out-of-date configurations.

5. To retrieve the current (most recent) IP Office configuration settings, from the menu, select
File  > Open Configuration.

6. In the Select IP Office window:

• If the required IP Office server is listed, use the check box to select your IP Office server
from the list of available servers.

• If the required IP Office server is not listed, in the Unit/Broadcast Address box type the
IP address for your IP Office server. Click Refresh to perform a new search. The IP Office
server then appears in the list of available servers. Use the check box to select your IP
Office server from the list of available servers.

IP Office configuration
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7. Click OK.

8. On the Configuration Service User Login message box, in the Service User Name box,
type the user name. The default name is Administrator.

9. In the Service User Password box, type the user password. The default password is
Administrator.

10. IP Office Manager opens and displays the current configuration data for your IP Office
server.

Configuring the data synchronization user account
About this task
Configure the user account used by IP Office to maintain data synchronization with Avaya Contact
Center Select. The name and password of this account must match the IP Office server details as
configured in Contact Center Manager Administration (CCMA) on the Avaya Contact Center Select
server.

For user data synchronization, IP Office connects to Avaya Contact Center Select using the Contact
Center Manager Administration “accssync” user account details.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the IP Office server, select System.

Configuring the data synchronization user account
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3. For IP Office Release 9.0.3, in the right pane, select the ACCS tab. For IP Office Release
9.1, select the Contact Center tab.

4. For IP Office Release 9.1, from the Contact Center Application list, select Avaya Contact
Center Select.

5. In the CCMA Address box, type the IP address of the Avaya Contact Center Select server.

6. In the CCMA Username box, type the name of the Avaya Contact Center Select data
synchronization user account. The default user name is accssync.

7. In the CCMA Password box, type the password of the Avaya Contact Center Select data
synchronization user account. The default user password is accssync.

8. Click OK.

Verifying the IP Route configuration
About this task
Verify the Local Area Network (LAN) Ethernet and IP Route configuration details to ensure IP Office
can communicate with IP Office Manager, Avaya Contact Center Select, and agent telephones.

IP Office configuration
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Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the IP Office server, select System.

3. Note the IP Office network settings. Note which network interface IP Office is using for local
communications. For Avaya Contact Center Select deployments, IP Office must use LAN1
for local communications.

4. In the Configuration pane, under the IP Office server, select IP Route. If there are no
existing IP Routes, right-click IP Route and select New.

5. On the IP Route tab, in the IP Address box, type 0.0.0.0.

6. In the IP Mask box, type 0.0.0.0.

7. In the Gateway IP Address box, type the IP address of your gateway.

8. From the Destination list, select the network interface that IP Office uses for local
communication. For example, select LAN1.

Verifying the IP Route configuration
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9. Click OK.

Configuring the SIP domain name
About this task
Configure the IP Office SIP domain name. A SIP domain is a logical space where SIP-enabled
devices exist, authenticate, and communicate.

In a SIP network a destination address consists of both a user and a domain. This is referred to as a
Uniform Resource Identifier (URI). The user portion of the URI is the destination that is being
communicated to and the domain portion is the logical grouping that the destination belongs to.

Important:
If you add or change the domain name of an active IP Office server, the IP Office server
restarts.

The Avaya Contact Center Select SIP domain name must match the IP Office SIP domain name.

IP Office configuration
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Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane. under the IP Office server, select System.

3. In the right pane, select the LAN1 tab.

4. Select the VoIP tab.

5. Enable SIP Registrar Enable.

6. In the Domain Name box, type the name of the SIP domain to be used with Avaya Contact
Center Select.

7. Click OK.

Configuring the SIP domain name
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Configuring the SIP User Extension number
About this task
Configure an IP Office SIP User Extension number. Avaya Contact Center Select uses this SIP User
Extension number and Telephony Supervisor Login Code password to register for CTI call control
and SIP session messaging.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the IP Office server, select User.

3. Right-click on User, and select New.

4. In the right pane, select the new User tab.

5. In the Name box, type a descriptive name for the user.

6. In the Password box, type a password for the user. For example, type 123456. This
password must be a number.

7. In the Confirm Password box, re-type a password for the user. For example, type 123456.

8. In the Extension box, type the extension number of the user. For example, type 6000.

9. Select the Telephony tab.

10. On the Telephony tab, on the Supervisor Settings sub-tab, in the Login Code box, type a
password for Avaya Contact Center Select registration. For example, type 123456. This
password must be a number.

11. Click OK.

12. On the Would you like a new VoIP extension created with this number message box,
select SIP Extension and click OK.

Configuring a short code for Contact Center Route Points
About this task
Configure a solution short code to map an IP Office telephone number to the Avaya Contact Center
Select SIP User Extension Number. A short code configures IP Office to perform an action if a
specific number is dialed.

For example:
• 3000 is configured in Avaya Contact Center Select as a CDN (Route Point).
• 6000 is configured in IP Office as the Avaya Contact Center Select SIP User Extension

Number.

IP Office configuration
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Create a short code 6000|>>3000. All customer calls to telephone number 3000 are forwarded to
extension 6000 and from there to Avaya Contact Center Select. Avaya Contact Center Select can
then treat the customer call and route it to a contact center agent.

A CDN (Route Point) is a logical address used by Contact Center to accept incoming contacts or as
a point to which contacts are routed. A Route Point is an address that enables incoming voice
contacts (phone calls) to be treated by Contact Center.

You can add multiple short codes and configure each one to map to an Avaya Contact Center
Select CDN (Route Point) number. If you create additional short codes to map IP Office calls to
Avaya Contact Center Select, you must add the corresponding CDN (Route Point) number in
Contact Center Manager Administration on the Avaya Contact Center Select server.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the Solution node, select Short Code, right-click and
select New.

3. In the right pane, in the Code box, type a CDN (Route Point) number. When this number is
matched, the other short code fields activate. For example, type 3000, where 3000 is an
Avaya Contact Center Select CDN (Route Point).

4. From the Feature list, select Dial Extn. If you do not see the Dial Extn option, ensure that
you have selected the Short Code menu item under Solution, and not the local Short Code
menu item for your IP Office. The Solution Short Code is common to all systems.

5. In the Telephone Number box, type the number output by the short code. For example, type
the following: 6000|>>3000
• Where 3000 is configured in Avaya Contact Center Select as a CDN (Route Point).

• Where 6000 is the Avaya Contact Center Select SIP User Extension Number.

Note: Ensure there are no spaces in the Telephone Number box.

If a customer dials 3000, then 3000 is sent to telephone number 6000 and Avaya Contact
Center Select.

Configuring a short code for Contact Center Route Points
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6. Click OK.

Configuring Contact Recording
Before you begin

• Ensure the Contact Recorder application is installed, configured, and working on your IP Office.
For more information about Contact Recorder, see Installing Contact Recorder for IP Office on
the Avaya Support web site at http://support.avaya.com.

About this task
Configure the User and User Rights settings to enable Contact Recording for Avaya Contact Center
Select agents and agent supervisors using IP Office.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the Solution node, select User Rights.

IP Office configuration
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3. In the middle pane, select Application.

4. In the right Application pane, select the User tab.

5. Select Application Servers Group.

6. Click OK.

7. In the right Application pane, select the Forwarding tab.

8. Select Enable Block Forward.

9. From the list, select Apply User Rights value.

Configuring Contact Recording
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10. Click OK.

11. Using IP Office Manager, select the IP Office server in the Configuration pane.

12. In the Configuration pane, under the IP Office server, select User.

13. In the middle pane, select the Avaya Contact Center Select SIP User Extension.

14. In the right pane, select the User tab.

15. From the Working hours Users Rights list, select Application.

IP Office configuration

30     Deploying Avaya Contact Center Select DVD December 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Contact Center Select DVD


16. Click OK.

17. On the Avaya Contact Center Select SIP User Extension user, select the Voice Recording
tab.

18. From the Inbound list, select None.

19. From the Outbound list, select On, and Internal.

Configuring Contact Recording
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20. From the Destination list, select Voice Recording Library.

21. Click OK.

Configuring IP Office extensions
Before you begin

• Skip this procedure if your Avaya Contact Center Select agents are using IP Office Softphone
with IP Office systems upgraded from IP Office Release 9.0.x.

• Skip this procedure if your Avaya Contact Center Select agents are using Avaya
Communicator for Windows with IP Office Release 9.1.

About this task
For Avaya Contact Center Select agents using SIP and H.323 physical desk phones, configure an
IP Office extension.

When you create an agent in Avaya Contact Center Select, data synchronization ensures that a
corresponding user is created in IP Office. For Avaya Contact Center Select agents using SIP and
H.323 physical desk phones, IP Office must have an extension for every IP Office user. You can
reuse existing IP Office extensions for this purpose. Alternatively, you must create one new IP Office
extension for each IP Office user that corresponds to an Avaya Contact Center Select agent. Avaya
Contact Center Select agents can then use these IP Office users and extensions to log on and
handle customer calls.

There are many different ways of providing a H.323 or SIP IP Office extension for each Avaya
Contact Center Select agent, the following procedure describes one method. Some IP Office

IP Office configuration
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Extension settings are not mergeable. Changes to these settings might require a reboot of the IP
Office system.

Important:
If your Avaya Contact Center Select agents are using IP Office Softphone with IP Office
systems upgraded from IP Office Release 9.0.x, do not create an extension for the
corresponding IP Office users. If your solution requires that Users have Extensions, select the
Force Login option.

If your Avaya Contact Center Select agents are using Avaya Communicator for Windows with IP
Office Release 9.1, do not create an extension for the corresponding IP Office users. If your
solution requires that Users have Extensions, select the Force Login option.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the IP Office server, select Extension.

3. Right-click and select New  > H323 Extension or select New > SIP Extension.

4. On the Extn tab, in the Extension Id box, type an extension number.

5. On the Extn tab, in the Base Extension box, type a base extension number. This is the
directory number of the extension's default associated user.

6. In the Phone Password box, type a password.

7. Click OK.

8. Ensure the IP Office server has an extension, with a configured base extension number, for
every IP Office user that corresponds to an Avaya Contact Center Select agent.

Saving the IP Office configuration data
Before you begin

• Install the IP Office Manager software on a client computer that can communicate with the IP
Office server.

About this task
Use IP Office Manager to save your configuration changes to the IP Office server.

Procedure
1. In IP Office Manager, in the Configuration pane, select your IP Office server.

2. From the main IP Office Manager menu, select File > Save Configuration.

3. On the Send Multiple Configurations window, use the check box to select your IP Office
server from the list.

4. Click OK.

Saving the IP Office configuration data
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IP Office Manager saves the offline configuration file to your IP Office server.

IP Office configuration
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Part 2: Avaya Contact Center
Select installation

Chapter 6: Avaya Contact Center Select
software installation

Build and configure a Microsoft Windows Server 2008 server, install the Avaya Contact Center
Select application software from a DVD, and configure Avaya Contact Center Select using a simple
configuration utility called the ignition wizard.

Downloading the most recent documentation
Before you begin

• Download the most recent version of Acrobat Reader.
• Access the Avaya Web site at www.avaya.com/support.

About this task
Download the most recent documentation to ensure you have the most recent updates. Updates in
the documentation accurately reflect the most recent changes in the software.

Procedure
1. Log on to the Avaya Web site.

2. Compare the versions of the documentation on the site with the versions you have.

3. If the version number on www.avaya.com/support is higher than your version, download the
latest version of the document.

4. Review the Avaya Web site for release notes and readme files.
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Installing Windows Server 2008 Release 2
Before you begin

• Ensure that your server meets the specifications listed in Avaya Contact Center Select Solution
Description.

Do not upgrade your operating system from a previous release. Contact Center is not
supported on an upgraded operating system.

• Configure servers for RAID as described in Avaya Contact Center Select Solution Description.
• Ensure that you have a DVD for Microsoft Windows Server 2008 Release 2 Service Pack 1.
• Know the IP address and network settings for the server.

About this task
Install the Microsoft Windows Server 2008 Release 2 Service Pack 1 operating system on the
server. During the installation, configure the Microsoft Windows Server 2008 settings as required.

Procedure
1. Insert the Microsoft Windows Server 2008 64-bit Release 2 Standard Edition or Microsoft

Windows Server 2008 64-bit Release 2 Enterprise Edition DVD into the DVD drive.

2. Install Windows Server 2008 Release 2 according to the instructions supplied by the DVD.

3. On the first install page, select your language for installation.

4. Click Next.

5. On the Installation window, select a Language to install from the list.

6. Select a Time and currency format from the list.

7. Select Keyboard or input method from the list.

8. Click Next.

9. Click Install Now.

10. Select an operating system from the list.

11. Click Next.

12. On the first Install Windows screen, read the terms of the license agreement and select I
accept the license terms.

13. Click Next.

14. Select Custom.

15. Select the disk partition on which you want to install Windows Server 2008.

Important:

You can use the partition management options to configure the partitions on your server.

16. Click Next.

The installation proceeds and automatically restarts the server several times.

Avaya Contact Center Select software installation
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17. After completing the installation, log on to the server as Administrator. Enter and confirm the
Administrator password.

18. In the Initial Configuration Tasks window, select Activate Windows and follow the
instructions or the Microsoft documentation to activate your server.

19. Select Set time zone and complete the information as required for your system.

20. Select Configure Networking and configure the network interface.

21. Select Provide computer name and domain and complete the information for your server
name and network settings. Avaya Contact Center Select is supported in a workgroup or in a
Windows domain.

22. Change the DVD drive letter to E: to ensure the correct drive letters are free for the Contact
Center application and database hard disk drives and partitions.

23. Configure the hard disk drives and partitions for this server using the Windows Server 2008
Server Manager - Disk Management utility.

Configure the following hard disk drives and partitions. For each partition, specify a volume
size in MBs that when formatted results in a disk partition that is equal to or greater than the
required minimum partition size.

Hard disk drive (Drive letter) Minimum un-formatted
volume size

Minimum size partition

Operating System drive (C: )

Including the 100MB Windows
boot loader System Reserved
partition.

82024 MB 80 GB

Application drive (D:) 122882 MB 120 GB
DVD drive (E:) — —
Voice Contact Server database
drive (F:)

215044 MB 210 GB

Multimedia Contact Server
database drive (G:)

204804 MB 200 GB

24. Install other required drivers for your hardware configuration.

Procedure job aid
Name Description
Computer name Do not use spaces or underscores or exceed 15

characters. The name must start with an alphabetic
character.

Server names must adhere to RFC1123. For more
information, see Avaya Contact Center Select
Solution Description.

Installing Windows Server 2008 Release 2
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Name Description
Avaya recommends that you configure the server
final production name before installing Avaya
Contact Center Select.

Disk drives Format the partitions as required for the server. For
more information, see Avaya Contact Center Select
Solution Description.

Domain name Configure as required for your site. Avaya Contact
Center Select is supported in a workgroup or in a
Windows domain.

Licensing modes Select Per server licensing mode.

Accept the default five concurrent connections.
Network components Configure IP Address, WINS, DNS. Configure a

static IPv4 address. Contact Center does not support
IPv6.

Network connections If the server has more than one NIC/adapter, ensure
contact center subnet appears first in the network
adapter binding order.

Partitions Configure C: drive to be a primary drive. Configure
the other drives on your server to meet the
requirements according to Avaya Contact Center
Select Solution Description for the server.

Regional settings window Configure as required for your site.

Installing the most recent supported operating system
service packs

Before you begin
• Access the Avaya hotfixes list on the Web site www.avaya.com/support.
• Install and configure Microsoft Windows Server 2008 64-bit Release 2 Service Pack 1 on your

server.
• Review the specifications on operating system service updates in Avaya Contact Center Select

Solution Description.

About this task
Avaya recommends that you install the most recent supported operating system service packs. You
must download the supported operating system service pack from the Avaya hotfixes list to ensure
your Contact Center server software functions correctly with the supported operating system
patches.

Avaya Contact Center Select software installation

38     Deploying Avaya Contact Center Select DVD December 2014
Comments? infodev@avaya.com

http://www.avaya.com/support
mailto:infodev@avaya.com?subject=Deploying Avaya Contact Center Select DVD


Procedure
1. Log on to the server and disable the Windows Update feature. There are a number of

methods for disabling the Windows Update feature, refer to the Windows Server 2008
documentation for a method suitable to your solution. Disabling the Windows Update feature
prevents Windows Server 2008 from automatically applying operating system patches and
potentially rebooting the server.

2. Review the Contact Center Service Packs Compatibility and Security Hotfixes Applicability
List to determine the most recent Contact Center supported patches or service packs.

3. Download the appropriate Microsoft Windows Server 2008 patches for the Contact Center
software installed on this server.

4. Install the most recent Windows Server 2008 service pack that is validated with Contact
Center by following the Microsoft Installation instructions.

Connecting the server to the network
About this task
Connect the Contact Center server to the local contact center subnet. Disable all unused Network
Adapters or Network Interface Cards (NICs) to improve network communications and prevent the
erroneous configuration of unused NICs during Contact Center server commissioning.

Ask your System Administrator to add a Domain Name System (DNS) static entry for this server.
Each Contact Center server in a domain requires a DNS static entry.

Procedure
1. Using a network cable, connect the Contact Center server to the contact center subnet. The

contact center subnet is the network on which the server software applications work together
to route contacts and generate reports. Use the ping command to test the contact center
subnet connection.

2. Log on to the server.

3. Click Start  > Control Panel  > Network and Internet  > Network and Sharing Center  >
Change Adapter Settings.

4. Right-click on the unused Network Adapter, and select Disable.

5. Repeat this procedure for all unused Network Adapters.

Connecting the server to the network
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Configuring the network adapter
Before you begin

• Ensure the network adapter supports Receive Side Scaling with a minimum of four queues.
• Ensure the network adapter uses the most recent driver.

About this task
Configure the network adapter to support Contact Center real-time network traffic. Enable Receive
Side Scaling and configure four queues.

Procedure
1. On the Contact Center server, click Start > Control Panel > Network and Internet  >

Network and Sharing Center > Change adapter settings.

2. Right-click on the contact center subnet Local Area Connection and select Properties.

3. Click Configure.

4. On the Properties window, click Advanced.

5. On the Advanced tab, from the Property list select Receive Side Scaling, and from the
Value list select Enabled.

6. From the Property list select Maximum Number of RSS Queues, and from the Value list
select RSS 4 Queues.

7. From the Property list select Receive Buffers, and from the Value list select Maximum.

8. Click OK.

Downloading the most recent Contact Center patches to
the server

Before you begin
• Download and install the most recent and supported updates for Microsoft Windows Server

2008 64-bit Release 2.
• Know the location at which you plan to install each Contact Center server software package.
• Ensure that you use one administrator account on your server to un-install and install software

updates.

About this task
To ensure that you have the most current software, download the most recent Contact Center
patches from www.avaya.com/support to the server you plan to install.

Procedure
1. Log on to the server using the administrator account.
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2. Create a folder <Drive>:\Avaya-ProductUpdates\ to save the software updates. Where
<Drive> is the drive letter on which you want to save the Contact Center software updates.

3. Download the most recent service pack file. Save and unzip the file on the Contact Center
server in the Avaya-ProductUpdates folder.

4. If new patches are available for the latest service pack, download and save the patches on
the Contact Center server in the Avaya-ProductUpdates folder.

5. Read the Contact Center Release Notes for the most recent instructions.

Enabling Microsoft Remote Desktop connection
Before you begin

• Install Microsoft Windows Server 2008 64-bit Release 2 on your server.
• Log on to the server with administrator privileges.

About this task
Enable Microsoft Remote Desktop connection as your remote access tool. Microsoft Remote
Desktop provides remote access for support on the server.

Procedure
1. Choose Start  > Control Panel  > System and Security.

2. In the System section, select Allow remote access.

3. Click the Remote tab.

4. Select Allow connections from computers running any version of Remote Desktop
(less secure).

5. Click OK.

6. Click Apply.

Configuring Data Execution Prevention
About this task
Configure the Data Execution Prevention (DEP) hardware and software to perform additional checks
on memory that protect the Contact Center server against malicious code exploitation.

Procedure
1. Log on to Windows as administrator.

2. Choose Start > Control Panel > System and Security.

Enabling Microsoft Remote Desktop connection

December 2014 Deploying Avaya Contact Center Select DVD     41
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Contact Center Select DVD


3. Click System.

4. In the System window, click Advanced system settings.

5. In the System Properties dialog box, click the Advanced tab.

6. Under Performance, click Settings.

7. In the Performance Options dialog box, click the Data Execution Prevention tab.

8. On the Data Execution Prevention tab, select Turn on DEP for essential Windows
programs and services only.

9. Click OK.

10. On the System Properties dialog box, click OK.

11. Click OK to restart the computer.

Disabling Admin Approval Mode for Windows Server 2008
administrators

About this task
Windows Server 2008 implements a security feature known as User Account Control (UAC). By
default, this feature causes applications run by local non built-in administrators to behave as if the
applications had been run by standard users. Perform this procedure to ensure that local
administrators get full privileges for running applications.

Procedure
1. Click Start  > Administrative Tools  > Local Security Policy.

2. Under Security Settings, expand Local Policies.

3. Select Security Options.

4. In the policy pane on the right, double-click on User Account Control: Run all
administrators in Admin Approval Mode.

5. Click the Local Security Setting tab, and select Disabled.

6. Click OK.

If prompted, restart the server.

Installing the DVD software
Before you begin

• Download the most recent Avaya Contact Center Select patches to the server.
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• Download the most recent Avaya Contact Center Select Release Notes.

About this task
Install the Avaya Contact Center Select software and enable your contact center to route contacts to
the agents.

Procedure
1. Read the Avaya Contact Center Select Release Notes for the most recent instructions.

2. Insert the Avaya Contact Center Select DVD into the DVD drive of your server.

3. If the installation does not automatically start, access the DVD drive and double-click
Setup.exe.

4. Click Install to install the necessary software libraries on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click
Accept. If you are prompted to restart the server, click Yes.

5. After the prerequisite software and libraries are installed, navigate to the Avaya Contact
Center Select DVD and double-click Setup.exe to install the application software.

6. The Avaya Contact Center Select installer starts and checks that the server meets the
minimum hardware and Operating System requirements:

• If the system checker detects server errors, it displays a System information window
listing the detected blocking issues. Review the displayed issues, click Cancel, and
consult Avaya Contact Center Select Solution Description to determine the actions to
resolve the issue.

• If the system checker detects non-blocking warnings, it displays a System information
window listing the detected issues. Review the displayed issues and consult Avaya
Contact Center Select Solution Description to determine the actions to resolve the issue.
You can ignore warnings if the potential impact to the operation of the contact center is
understood and not applicable. Click Ignore or Cancel.

• If the system checker does not detect issues, the System information window is not
displayed.
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7. The Installation destination window appears.

8. From the Voice Contact Server Database Drive list, select the drive for the Contact Center
Manager Server and Communication Control Toolkit databases.

9. From the Multimedia Contact Server Database Drive list, select the drive for the Contact
Center Multimedia database.

10. In the Service Packs section, browse to locate the folder containing the Avaya Contact
Center Select product updates.

11. Click Install.

12. If a warning message box appears, you can ignore the warning if the potential impact to the
operation of the contact center is understood or not applicable. To proceed with the
installation, click Yes.
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13. The License Agreement window appears.

14. Read the terms of the agreement. If you accept the terms, click Accept.
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15. The Progress window appears and displays the installation progress.
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16. After a successful installation, the following window appears.

17. Select Launch Avaya Contact Center Select Ignition Wizard.

18. Click Configure.

The system launches the Avaya Contact Center Select Ignition Wizard.

Next steps
Use the Ignition Wizard to configure Avaya Contact Center Select. For more information, see 
Configuring the server installation data on page 48.
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Configuring the server installation data
Before you begin

• Obtain an Avaya Contact Center Select license file for your server and load the license file onto
a USB memory stick.

• Know the IP address of the IP Office primary call server.
• Know the IP Office Service User account name and password.
• Know the IP Office System Password. Ask your IP Office Administrator for the System

Password.
• Configure an IP Office SIP User Extension Number to be used to register Avaya Contact

Center Select.
• Configure an IP Office short code to forward customer calls to an Avaya Contact Center Select

CDN (Route Point).
• If your Avaya Contact Center Select solution is going to support email contacts, know the IP

address or name of your email host server.
• If your Avaya Contact Center Select solution is going to support email contacts, configure the

mailbox details on your email server that you use to receive inbound email messages intended
for the Avaya Contact Center Select. Know the name and password for this mailbox.

About this task
Configure the Avaya Contact Center Select installation data to enable communication with an IP
Office primary call server.

Optionally, if your solution is to support routed email contacts, configure the mailbox details on your
email server that you use to receive inbound email messages intended for the Avaya Contact
Center Select. Avaya Contact Center Select logs onto this mailbox on your mail server and retrieves
email at defined intervals. Email messages are then routed to agents. To route an email, Avaya
Contact Center Select requires the mailbox name and password.

Procedure
1. Log on to the Avaya Contact Center Select server using the Administrator account details.

2. The Avaya Contact Center Select Welcome screen appears.
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3. Click Next.
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4. On the license screen, select I Accept the Terms of the End-User License Agreement.

5. Click Next.
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6. On the Configuration Data screen, select the IP Office tab.

7. In the IP Office Server section, in the IP Address box, type the IP address of the IP Office
primary call server.

8. In the Voice Port box, type the port number of the IP Office primary call server. The default
port number is 5060.

9. From the Transport list, select the network transport communication protocol for the IP
Office primary call server. The default protocol is TCP.

10. In the IP Office SIP Domain Name box, type the SIP domain name of your IP Office primary
call server. The Avaya Contact Center Select SIP domain name must match the your IP
Office SIP domain name.

11. In the IP Office SIP Extension section, in the Extension Number box, type the IP Office
SIP User Extension Number used to register Avaya Contact Center Select. For more
information, see Configuring the SIP User Extension Number on page 26.

12. In the IP Office SIP Extension section, in the Password box, type the password of the IP
Office SIP User Extension Number used to register Avaya Contact Center Select. Enter the
number that you configured for the Supervisor Settings - Login Code on the user’s
Telephony tab. For more information, see Configuring the SIP User Extension Number on
page 26.
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13. In the IP Office SIP Extension section, in the Confirm Password box, re-type the
password.

14. In the IP Office Service User section, in the Username box, type the Service User Name of
the IP Office Manager for your IP Office call server. For more information, see Using IP
Office Manager on page 20.

15. In the IP Office Service User section, in the Password box, type the Service User
Password of the IP Office Manager for your IP Office server.

16. In the IP Office Service User section, in the Confirm Password box, re-type the password.

17. In the IP Office System Password section, in the Password box, type the System
Password for your IP Office call server. Ask your IP Office Administrator for the System
Password.

18. In the IP Office System Password section, in the Confirm Password box, re-type the
System Password for your IP Office call server.

19. In the Contact Center Sample Data section, in the Sample Agent Starting ID box, type a
phone number for the first sample Avaya Contact Center Select agent. Avaya Contact
Center Select automatically creates ten sample agents, using this number as the first of ten
sequential agent numbers. The default number is 6001.

20. In the Sample CDN Number box, type a number for the Avaya Contact Center Select CDN
(Route Point). This number must match an IP Office short code entry number. For more
information, see Configuring a shortcode to Contact Center Route Points on page 26. The
default number is 3000.

21. Select the Core tab.
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22. From the IP Office Contact Center Media Server Locale list, select the locale (including
language and dialects) of the solution environment.

23. In the System Account Configuration section, in the Password box, type a password for
the Avaya Contact Center Select administration account. The password is not checked
against the server security policy for minimum password requirements. Avaya recommends
that you enter a password that conforms to your corporate password policy.

24. In the Confirm Password box, type the password.

25. Select the Licensing tab.
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26. Click Browse, and navigate to folder or USB device containing your license file. Load the
XML license file. If you do not have a USB memory stick or a license file, you can click Skip
and load the license file later. If you defer licensing configuration, the deferred configuration
process is more complex and an additional server reboot is required. Avaya recommends
that you configure Contact Center licensing here using this Licensing tab.

27. Select the Multimedia tab.
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28. In the Mailbox Configuration section, from the Mail Provider list, select None, Microsoft
Exchange, Gmail, Outlook Hotmail, Yahoo, or Other (POP3/IMAP). The default is Microsoft
Exchange. If Avaya Contact Center Select is not going to process email contacts, select
None. If you select Gmail, Outlook Hotmail, or Yahoo, the Incoming Mail Server and
Outgoing Mail Server sections are automatically populated for you.

29. In the Mailbox Configuration section, in the Display Name box, type a display name for the
mailbox.

30. In the Mailbox Configuration section, in the Email box, type the email address for the
mailbox. For example, sales@company.com.

31. In the Mailbox Configuration section, in the Password box, type the password for the
mailbox.

32. In the Mailbox Configuration section, in the Confirm Password box, re-type the password
for the mailbox.

33. In the Incoming Mail Server section, in the Host Name box, type the name of the server on
which email messages are received in your network.

34. In the Incoming Mail Server section, from the Protocol list, select the communication
protocol for the inbound email server. Select POP3 or IMAP. The default protocol is POP3.
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35. In the Incoming Mail Server section, from the Encryption list, select the encryption type to
use. Select Cleartext, SSL, or TLS. The default encryption type is Cleartext.

36. In the Incoming Mail Server section, in the Port box, type the port number of the incoming
email server. For the POP3 protocol, the default port number is 110. For the IMAP protocol,
the default port number is 143.

37. In the Outgoing Mail Server section, in the Host Name box, type the name of the server
from which email messages are sent. Your inbound and outbound mail servers can have the
same name.

38. For outgoing email, the Protocol is SMTP.

39. In the Outgoing Mail Server section, from the Encryption list, select the encryption type to
use. Select Cleartext, SSL, or TLS. The default encryption type is Cleartext.

40. In the Outgoing Mail Server section, in the Port box, type the port number of the outgoing
email server. The default port number is 25.

41. In the Outgoing Mail Server section, from the SMTP Authentication list, select SMTP
Authentication Disabled or Base 64 Encoded Authentication. The default authentication
method is Base 64 Encoded Authentication.

42. Click Next.

43. On the Ready to Perform Ignition screen, confirm your inputs, and click Configure.

The configuration utility begins to configure the Avaya Contact Center Select components.

44. When the components are configured, the Configuration Complete screen appears.
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45. Click Finish.

46. On the Avaya Contact Center message box, click OK to restart the Avaya Contact Center
Select server.

Avaya Contact Center Select software is now installed.

Using the Contact Center Dashboard
About this task
You can use the Contact Center Dashboard to access Contact Center system tools and diagnose
system problems. The Contact Center Dashboard displays some Operating System and system
details such as CPU type, network details, and Operating System activation status.

The Contact Center Dashboard launches automatically the first time the Contact Center server
boots up. You can configure the Contact Center Dashboard to launch every time the server reboots
and starts up.
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Procedure
1. The Contact Center Dashboard Welcome message box automatically appears the first time

the server starts up.

2. Click OK.
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3. On the Contact Center Dashboard, select the Home tab.

4. Click Refresh All to refresh the Contact Center Dashboard status reports.

5. In the Avaya Contact Center Status section, click View Services to monitor the state of the
Contact Center Windows services.

6. In the Avaya IP Office Server Availability section, click SIP Gateway Monitor to determine
if Contact Center is communicating with IP Office.
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7. Select the Connectivity tab.

8. In the SIP Gateway Monitor section, click Launch to monitor the status of the SIP
connection to IP Office.

9. In the Contact Center Multimedia Dashboard section, click Launch to monitor the
multimedia mailbox status.

10. In the Contact Center Manager Administration section, click Launch to access Contact
Center Manager Administration to configure and manage Contact Center resources.

11. In the System Control and Monitoring Utility section, click Launch to monitor, stop, and
start Contact Center services.

12. In the Contact Center License Manager section, click Launch to monitor license status
and add additional licensed features.

13. Select Business Continuity Support to configure the Business Continuity feature.
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14. Select the Software tab.

15. Contact Center Version displays the version of the Contact Center software installed on the
server.

16. Avaya Media Server displays the version of Avaya Media Server software installed on the
server.

17. Contact Center Services for Avaya Media Server displays the version of Contact Center
Services for Avaya Media Server software installed on the server.

18. Ignition Status displays the Contact Center software installation status.

19. Avaya Contact Center Components displays the Contact Center software and patch line-
up installed on the server.

20. Third Party Software Information displays the versions of the third-party software
components used by Contact Center that are installed on the server.
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21. Select the System tab.

22. Machine Name displays the host name of the Contact Center server.

23. Windows Domain displays the name of the domain that the Contact Center server is in.

24. Operating System displays the Operating System version.

25. Windows Activation Status displays the Windows Operating System license and activation
status.

26. RAM displays the amount of RAM memory in the server.

27. CPU displays the type of CPU in the server.

28. Network displays the networking details of the server: IP address and MAC address.

29. Hard Disks displays the number, size, and drive letter of the hard disk volumes in the
server.
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30. Select the Troubleshooting tab.

31. Select System Errors to access Contact Center events in the Microsoft Windows Event
Viewer.

32. Select Contact Center Log Files to access Contact Center trace log files.

33. Select Server Configuration to configure Contact Center licensed features and IP Office
voice network settings.

34. Select Contact Center Documentation to access and download the most recent Contact
Center documentation from the Avaya support web site.

Logging on to Avaya Media Server Element Manager
Before you begin

• Obtain a valid user name and password to access Avaya Media Server Element Manager.
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About this task
Log on to the Avaya Media Server Element Manager as an administrator to configure Avaya Media
Server.

Element Manager (EM) is a web-based administration tool that facilitates the Operation,
Administration, and Maintenance (OAM) of Avaya Media Server. A SIP-enabled Contact Center
solution must contain one or more Avaya Media Server servers. Each Avaya Media Server server in
the Contact Center solution must be licensed and configured to provide media services.

Procedure
1. On a client computer, start a Web browser.

2. In the address box, enter https://SERVER_IP_ADDRESS:8443/em. Where
SERVER_IP_ADDRESS is the IP address of the Avaya Media Server.

3. In the User ID box, type the Avaya Media Server User ID log on account name. The default
Element Manager User ID account name is the Avaya MS server administrator account
name. If Avaya Media Server is installed on a Windows server, the default administrator
account name is Administrator. If Avaya Media Server is installed on a Linux server, the
default administrator account name is amsuser.

4. In the Password box, type the Avaya Media Server Element Manager password. The default
Element Manager password is the administrator password for the Avaya MS server.

5. Click Log in.

Configuring Avaya Media Server Processor Affinity
Settings

About this task
Configure the Avaya Media Server Processor Affinity Settings to support real-time contact center
network traffic.

Procedure
1. Log on to Avaya Media Server Element Manager.

2. In the left pane, select System Configuration.

3. Select Server Profile  > Processor Affinity.

4. On the Processor Affinity Settings pane, in the Processor Affinity section, clear the
Allow Execution checkbox for each of the cores in the first physical socket, Socket 0.
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Part 3: User Contact Recording
configuration

Chapter 7: User Contact Recording Pause
and Resume configuration

Avaya Contact Center Select supports IP Office Call Recording. IP Office Call Recording provides
regulatory type recording, including the option to pause automatic recording for Payment Card
Industry (PCI) security compliance. Avaya Contact Center Select supports the Call Recording pause
and resume feature when it is initiated from a physical phone set. The Agent Desktop user interface
does not have a pause button. Agents and agent supervisors must use their physical phone to
pause and resume voice contact recording.

If your Avaya Contact Center Select agents and agent supervisors must be able to pause contact
recording, add a Pause Recording button to each of their associated IP Office users.

Using IP Office Manager
Before you begin

• Install the IP Office Manager software on a client computer.
• Ensure the client computer can communicate with the IP Office server.

About this task
IP Office Manager is a component of the IP Office administration suite of applications. You use IP
Office Manager to configure IP Office. IP Office Manager runs on a Windows computer and
connects to the IP Office system using an Ethernet LAN connection.

IP Office Manager is an off-line editor. Use IP Office Manager to connect to your IP Office server
and retrieve a local copy of the IP Office current configuration settings. You can then edit the local
copy of the IP Office configuration and when you are ready, save your updated configuration data
back to the IP Office server.
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Procedure
1. On the client computer, select Start > All Programs  > IP Office  > Manager.

2. On the Configuration Service User Login message box, in the Service User Name box,
type the user name. The default name is Administrator.

3. In the Service User Password box, type the user password. The default password is
Administrator.

4. From the menu, select File  > Close Configuration. This closes any open and potentially
out-of-date configurations.

5. To retrieve the current (most recent) IP Office configuration settings, from the menu, select
File  > Open Configuration.

6. In the Select IP Office window:

• If the required IP Office server is listed, use the check box to select your IP Office server
from the list of available servers.

• If the required IP Office server is not listed, in the Unit/Broadcast Address box type the
IP address for your IP Office server. Click Refresh to perform a new search. The IP Office
server then appears in the list of available servers. Use the check box to select your IP
Office server from the list of available servers.

7. Click OK.

8. On the Configuration Service User Login message box, in the Service User Name box,
type the user name. The default name is Administrator.

9. In the Service User Password box, type the user password. The default password is
Administrator.
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10. IP Office Manager opens and displays the current configuration data for your IP Office
server.

Configuring a Pause Recording button for users
Before you begin

• Ensure the Contact Recorder application is installed, configured, and working on your IP Office.
For more information about Contact Recorder, see Installing Contact Recorder for IP Office on
the Avaya Support web site at http://support.avaya.com.

About this task
Configure a Pause Recording button for each Avaya Contact Center Select (agent and agent
supervisor) user. The button status indicates when call recording is paused. Pressing the button
again restarts call recording. The IP Office system can also automatically restart recording after a
set delay.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, select your IP Office server.

3. In the left pane, select User and select the individual user.

4. In the right pane, select the Button Programming tab.
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5. From the user Button list, select the number of the button on which you want to program
Pause Recording and click Edit.

6. In the Edit Button section, click the Action browse “…” button.
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7. Select Advanced  > Call > Pause Recording.
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8. In the Label box, type a description to appear on the telephone display.

9. Click OK.
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10. On the Button Programming tab, click OK.

11. Repeat this procedure for each IP Office user that represents an Avaya Contact Center
Select agent or agent supervisor. Avaya recommends that you configure Pause Recording
on the same button number for all users. Avaya recommends that you label each Pause
Recording button with the same description.

12. Continue to add a Pause Recording button to each new IP Office user that represents a new
Avaya Contact Center Select agent or agent supervisor.

Configuring the Contact Recording Auto Restart Delay
Before you begin

• Ensure the Contact Recorder application is installed, configured, and working on your IP Office.
For more information about Contact Recorder, see Installing Contact Recorder for IP Office on
the Avaya Support web site at http://support.avaya.com.

Configuring the Contact Recording Auto Restart Delay
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About this task
By default, Contact Recording automatically restarts a paused recording after 15 seconds.
Configure the Auto Restart Paused Recording setting for your solution.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, select your IP Office server.

3. In the left pane, click System.

4. Click the Voicemail tab.

5. Set Auto Restart Paused Recording to the required time in seconds.

6. Click OK.

User Contact Recording Pause and Resume configuration
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Saving the IP Office configuration data
Before you begin

• Install the IP Office Manager software on a client computer that can communicate with the IP
Office server.

About this task
Use IP Office Manager to save your configuration changes to the IP Office server.

Procedure
1. In IP Office Manager, in the Configuration pane, select your IP Office server.

2. From the main IP Office Manager menu, select File > Save Configuration.

3. On the Send Multiple Configurations window, use the check box to select your IP Office
server from the list.

4. Click OK.

IP Office Manager saves the offline configuration file to your IP Office server.

Saving the IP Office configuration data
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Part 4: First phone call and first
email

Chapter 8: Agent Desktop

Agent Desktop is a single-interface client application used to interact with customers. You can use it
to respond to customer contacts through a variety of media, including phone, outbound contacts,
email, Web communication, fax, scanned documents, and Short Message Service (SMS) text
messages.

Agent Desktop provides automation for customer responses to eliminate repetitive actions, such as
typing a common response in an email message.

Note:

Agents must use Agent Desktop to handle voice and multimedia contacts. Avaya Contact
Center Select does not support telephone-only operations for voice agents.

Agent Desktop User Interface
Use Agent Desktop to handle voice, email, Web communications, SMS text message, voice mail,
fax, and scanned documents contacts. Use Agent Desktop in the following situations:

• to handle voice contacts in a voice-only contact solution

• to handle voice contacts, email messages, or Web communications contacts in a voice and
multimedia contact solution

This chapter describes the main user interface of the Agent Desktop application. There are three
main sections to the Agent Desktop user interface:
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Figure 1: Example of Agent Desktop layout

1 Top bar on page 75
2 Work list window on page 76
3 Action bar on page 77

Agent Desktop also provides other controls and menus that are explained in the following chapters.

Work Item paradigm
The main Agent Desktop user interface is based on a work item paradigm. Each agent-to-customer
interaction is a work item. Work items appear on the Agent Desktop work list.

The work list consists of work items and control buttons corresponding to the work item. The
controls and functions change depending on the work list window behavior. When a new contact
arrives, Agent Desktop adds the new contact as a work item to the work list.

Top bar
The Top bar appears at the top of the Agent Desktop window. The Top bar provides the system
status and main controls to operate the Agent Desktop.

Figure 2: Example of Top bar layout

The agent status icon appears on the top left corner of the Agent Desktop Top bar. The Top bar also
displays the agent status, agent name, agent login ID, and dialable number of the agent.

The Top bar has the following icons:

Table 1: Top bar icons

Icon Name Description
Agent status Select agent status.

Terminal Actions Access Emergency.

Agent Desktop User Interface
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Icon Name Description
User preferences Access user preferences, open the Dashboard, and

change work item display settings.
Help Access help information.

Use the Terminal Action menu to perform the following tasks:

Table 2: Terminal Action Menu

Command Description
Emergency Immediately connect with your supervisor in case of emergency.

Work list window
The work list window contains work items and control buttons corresponding to the work item. The
controls and functions change depending on the information in the work list window. The top-right
corner of the work list window has work item controls. These controls are common to all work items
on the work list. When a new contact arrives, Agent Desktop adds the new contact as a work item to
the work list.

The following figure shows the work list windows and controls.

Figure 3: Example of work list layout

The illustrated work list shows two work items:

1 An email work item, at the top of the work list.
2 A voice call work item, at the bottom of the work list.

• A work item is a collection of interactions with a customer, another agent, a supervisor, or an
expert.

• A work list is a collection of work items. When you receive a new contact, it is added to the
work list so that you can monitor your current contacts. When you finish with the contact, or
reject the contact, the work item is removed from the list.

Work item controls: 

Each work item has a number of contact-related controls. These controls change depending on the
work list window behavior and contact type.

Agent Desktop
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Table 3: Examples of work item controls

Voice Email Name Description
Accept Accept the work item.

Release Release or reject the work item.

Hold Place the work item on hold.

Transfer Transfer the work item contact.

Conference/Join Conference the work item. Or join two work
items.

Activity code Set the work item activity code.

Work item details Read work items details.

Only appropriate controls are displayed on work items. Voice-related controls are displayed on voice
work items. Email-related controls are displayed on email work items.

Action bar
The Action bar contains global controls to create a new work item, to search contacts, and to open
secondary windows. The Action bar is located at the bottom of the Agent Desktop window.

Figure 4: Example of Action bar layout

Use the Action bar at the bottom of the main interface to make new contacts. New voice or email
contacts are collectively called new work in the Work Item Paradigm.

Table 4: Action bar commands

Icon Name Description
Customer Details View customer details.

Contacts Presence Contact presence.

Observe Listen in or participate in agent-customer calls or chat
sessions.

(Used by agent-supervisors only)
Phonebook Contact agents through the LDAP agent contact

directory.

Agent Desktop User Interface
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Icon Name Description
Originate Call Start a new work item.

Supervisor Call your supervisor.

DTMF Generate Dual-tone Multi-frequency (DTMF) tones.

Contact Search Search for contacts.

Customer Search Search for customers.

Schedule Callback Schedule a callback.

Agent Statistics Display the agent statistics scroll bar.

Email User Interface
Use Agent Desktop to handle incoming email messages. You can also use Agent Desktop to create
a new email message.

Figure 5: Example of email toolbar

The Agent Desktop email editor offers improved email editing, formatting feature buttons, and
management in HTML format email messages.

The following table describes the email feature buttons:

Table 5: Email editing and formatting controls

Control Name of the
Control

Function

Bold Bold the selected text

Italic Italicize the selected text

Agent Desktop
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Control Name of the
Control

Function

Underline Underline the selected text

Left Align text with left margin

Center Center text

Right Align text with right margin

Justify Justify text

Numbers Numbered list items

Bullets Bulleted list items

Indent Indent selected text

Outdent Outdent selected text

Undo Undo last change

Redo Redo the last change

Color Change color of selected text

Link Insert a hyperlink

Image Insert an inline image

Insert a file Insert an email attachment

SpellCheck Spell check the email message

Insert Signature Insert a signature to the email message

Insert a Template Email templates

Rule Adds a continuous line under the selected location
Highlight Highlights selected text with a color chosen from the color

palette

Agent Desktop User Interface
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Installing Agent Desktop software using ClickOnce
Before you begin

• Ensure the client computer meets the hardware and networking requirements for Agent
Desktop software. For more information about Agent Desktop requirements, see Avaya
Contact Center Select Solution Description.

• Ensure the client computer meets the Operating System requirements for Agent Desktop
software. For more information about Agent Desktop requirements, see Avaya Contact Center
Select Solution Description.

About this task
Install Agent Desktop software to handle Avaya Contact Center Select customer contacts.

Procedure
1. In Windows Explorer or Internet Explorer, type the HTTP address (URL) provided by your

system administrator.

The URL format is:

http://<ContactCenterServerName>/agentdesktop
Where <ContactCenterServerName> is the Avaya Contact Center Select server name.

2. Click Install Prerequisites and follow the on screen instructions to install the .NET and
operating system components required to run Agent Desktop software.

Agent Desktop
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3. Click Launch to download and install the most recent version of Agent Desktop software.

Logging on to Agent Desktop
About this task
Log on to Agent Desktop and change into the ready state to handle customer contacts.

To support rapid and easy deployment, Avaya Contact Center Select provides some default users
and supervisors.

The default sample supervisor “6001” can handle both voice contacts and email messages. To test
both voice contacts and email messages, log on as supervisor “6001” and use the default password
“Pw_6_001”.

The default sample user “6002” can handle only voice contacts. To test voice contacts, log on as
user “6002” and use the default password “Pw_6_002”.

If you entered a different Sample Agent Starting ID when running the Avaya Contact Center Select
Ignition Wizard, the logon IDs and passwords entered here are not the default sample values. If you
use agent IDs that are different to the sample values, then the password format is
Pw_firstdigit_remainingdigits. For example, if you entered a Sample Agent Starting ID of 7701, then
your first supervisor “7701” has the password “Pw_7_701”. Agent “7702” has a password of
“Pw_7_702”.

Logging on to Agent Desktop
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Note:
You must be logged on to the desktop phone before you log on to Agent Desktop.

Procedure
1. On the Agent Desktop client computer, click Start  > All Programs  > Avaya  > Avaya Aura

Agent Desktop 6.0.

2. On the User Credentials window, in the User ID box, type the agent user ID. For example,
type 6002.

3. In the Password box, type the password for the agent. For example, type Pw_6_002.

4. In the Domain box, type the host name of the Avaya Contact Center Select server.

5. Click OK.

6. On the Agent Desktop Top bar, from the Status list, select Login.

Agent Desktop

82     Deploying Avaya Contact Center Select DVD December 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Contact Center Select DVD


7. On the Multimedia Agent Logon window, click Login.

8. If the user is configured to handle multimedia contacts (such as email), on the Multimedia
tab, type the user ID and Password and click Login. Use the same user ID and password
as above.

For example:

Logging on to Agent Desktop
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9. The status icon changes to Not Ready.

Changing your status to Ready
About this task
Change your status to Ready when you are available to create and receive contacts.

Agent Desktop
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Procedure
1. On the Agent Desktop Top bar menu, click the Status icon.

2. Select Go Ready to create or receive both Voice and Multimedia contacts.

The status icon changes to green.

Making a test phone call to the contact center
Before you begin

• Ensure an Avaya Contact Center Select agent is logged on to Agent Desktop and is in the
ready state.

About this task
Make a test phone call to the Avaya Contact Center Select CDN (Route Point).

Procedure
1. Using an IP Office phone, dial the Avaya Contact Center Select CDN (Route Point) phone

number. For example, dial 3000.

2. Listen for a ringback tone.

3. Listen for the “Welcome to the Contact Center” announcement.

4. Listen for the following voice prompt menu:

• “Press 1 to speak to an agent at the help desk.”

• “Press 2 to speak to an agent in the support center.”

• “Press 3 to Enter your pin number or any eight digits of your choosing.“

• “Press 4 to leave a voice mail.”

• “Press * to repeat this menu.”

5. To make a test phone call and speak with an agent, press button 1 on your phone.

6. Listen for another ringback tone as your call is routed to an available Avaya Contact Center
Select agent.

7. Wait for the call to be answered by an agent.

Making a test phone call to the contact center
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Accepting a call
Before you begin

• Ensure that you have set your status to Go Ready.
• Ensure that you are assigned to a skillset for handling telephone calls.

About this task
Accept and work with telephone calls. The relevant work item controls become active and the call
timer appears on the work item.

If your administrator has configured your Contact Center to run in the Call Force Delay mode, you
must handle all contacts presented to you.

Procedure
On the Agent Desktop, select the new alerting work item and click the Accept work item control.

Example of an alerting CDN call:

Example of an answered CDN call:

The agent can now speak with the customer.

Entering an Activity code
About this task
You can enter one or more Activity codes during calls by using the Agent Desktop Top bar activity
inline command. Activity codes provide a method to track the time that agents spend on various
types of calls. For example, you can enter a Sales activity code in Agent Desktop during a sales-
related call.

Your supervisor or system administrator configures Activity codes. Administrators define Activity
codes in Contact Center Manager Server. Activity codes can be alphanumeric. Agent Desktop
displays the Activity codes list.

Agent Desktop
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Agent Desktop displays the Activity Code box on the work item based on your Contact Center
configuration. Administrators can configure activity codes that correspond to a contact type and a
skillset. Therefore, Activity codes are filtered on a contact type and skillset basis. For example, if you
are handling email contacts, Agent Desktop populates the Activity Code list with activity codes that
correspond to the email contact type and skillset.

Procedure
1. Select the work item.

2. Click the Activity Code work item inline command.

3. From the Select or type an Activity Code drop-down list, select or type the activity code.

Ending a call
About this task
End a call when a call is completed. If your status was Ready before the call, your status is
automatically set to Ready, when you terminate the call. If you require time to perform call wrap-up
tasks, before you accept another call, select Set ACW Code and enter the After Call Work Item
(ACW) code in the Code field of the Top bar. If you require to change your status to Not Ready and
enter a Not Ready Reason Code in the Code field of the Top bar. The administrator defines Not
Ready Reason and ACW codes.

Procedure
On the work item, click Release.

Making a call
About this task
Make a call using Agent Desktop. Ensure that you follow the steps based on the type of phone
number you want to call:

• the default phone number
• a new external phone number
• a new internal phone number

Ending a call
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Procedure
1. On the Agent Desktop Action bar menu, click Initiate Call.

2. In the Initiate Call text box, enter the phone number to dial.

3. Click Initiate Call again.

The phone number is dialed. A new work item is added to the work list and the call timer on
the work item starts to increment.

4. Click Release when you complete the call.

Sending a test email message to the contact center
Before you begin

• Know the name of a mailbox monitored by Avaya Contact Center Select.

About this task
Send a test email message to Avaya Contact Center Select.

Procedure
1. Create an email message.

2. Send the email message to the mailbox monitored by Avaya Contact Center Select.

3. Avaya Contact Center Select processes the email. You might receive an automated
acknowledgement of your email before an Avaya Contact Center Select agents responds.

Accepting an incoming email message
About this task
Accept an incoming email message, when you are ready to receive the customer's email, display
customer details and begin contact with a customer. The Agent Desktop displays the customer

Agent Desktop
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details and the call timer appears on the work item. The new incoming email message is presented
as a new work item in the Work List window.

Procedure
On the Agent Desktop, click Accept.

The email message opens in the E-mail Display panel.

The customer details associated with the email message appears in the bottom left-hand corner of
the Customer Details panel.

Replying to an email message
Before you begin

• Accept an email contact.

About this task
Reply to an email message when a customer sends an email message to the Contact Center
requesting a response. Create a response to a customer in the same format as the original request.

You can use several features (present in the following list) in the Agent Desktop interface to create
your email response in HTML or plain text:

• Auto suggestions
• the address book
• one or more response templates
• an automatic signature
• an attached file
• the spelling checker

You can also add a comment to an email message in the Agent Note box as a reference for later
communications with the customer. The customer does not see the information present in the Agent
Note box.

Procedure
1. On the Agent Desktop, in the Email window, click Reply.

2. In the E-mail Response window, accept the default To email address. The default email
address is the address from which the message was sent.

Or

Click To to add a email address of the customer, which is other than the default email
address.

Or

Click Cc to add other email addresses from the corporate address book or multimedia
database.

Replying to an email message
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3. In the Subject box, either accept the subject currently displayed or edit the subject.

4. Add text to the reply using one or both of the following methods:

• Type the message text.

• Add a template response.

5. If you use the HTML format for creating the email message, and you want to make the text
bold, underline, or italics, select the text, and click the appropriate button to apply formatting.

You cannot format a plain text email message.

6. To change the text size, select the text and click the up arrow to increase the font size, or
click the down arrow to decrease the font size.

7. To perform a spell check, click the SpellCheck icon.

8. To insert an automatic signature to the email message, click the Insert Signature icon.

9. To add an attachment to the email response, click Insert a file.

10. In the Agent Note box, type additional information about the contact or the customer, if
required.

Only agents and supervisors can view the information in the Agent Note box.

11. Click Send.

12. Close the contact.

If required, select a reason for closing the contact.

Logging off from Agent Desktop
Before you begin

• Ensure that you do not have a contact open. If a contact is open, you must close the contacts
before you log off of the application.

About this task
Log off from Agent Desktop when you are ready to exit the application.

Procedure
1. On the Agent Desktop Top bar menu, click the Status icon.

2. Click Log Out.

Agent Desktop logs you off. The status icon changes to red and the Top bar displays the
Logged Out status.

Agent Desktop
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Part 5: Maintenance

Chapter 9: Maintenance procedures

This section describes how to maintain the Avaya Contact Center Select software and server. You
must maintain Avaya Contact Center Select to protect against data loss and to ensure that you are
using the most recent software.

Database maintenance
Perform an immediate backup of the Avaya Contact Center Select databases to save the current
data. It is important to complete this procedure after you complete your installation or when any
significant change occurs in the database, so that you can restore the database easily. Perform
backups during low traffic periods. Avaya Contact Center Select services are not shut down during
backups. Back up the databases to a secure network location. Schedule regular backups of the
Avaya Contact Center Select databases to ensure resiliency against media failure or data loss.

Contact Center Software patches
Apply the most recent Avaya Contact Center Select patches to ensure that you have the most
recent version of the application software and to resolve software issues.

Install the latest operating system service packs that are supported for Avaya Contact Center
Select. You must download the latest supported operating system service pack from the Avaya
hotfixes list to ensure your Avaya Contact Center Select server software functions correctly with the
supported operating system patches.

Adding the server to a domain
Before you begin

• Ensure that you have domain administrator privileges, or ask the Domain Administrator to
assign you a domain user account for remote access.

• On the server, configure a preferred Domain Name System (DNS) server on the Network
Interface Card (NIC).
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About this task
Add the server to an existing domain. Ask your System Administrator to add a Domain Name
System (DNS) static entry for this server. Each Contact Center server in a domain requires a DNS
static entry.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. Click Start  > Administrative Tools  > Server Manager.

3. Beside Computer Information, click Change System Properties.

4. In the System Properties dialog box, click the Computer Name tab.

5. Click Change.

6. In the Computer Name/Domain Changes dialog box, click the Domain option.

7. Type the domain name. You must provide the fully qualified domain name, which includes
the prefix and suffix.

8. Click OK.

9. Type the domain administrator User name and Password.

10. Click OK.

11. Restart the server when you are prompted to do so.

Backing up the administration data
Before you begin

• Ensure that you have write privileges on the server where you want to store the administration
data you are backing up.

About this task
Back up the administration data to a folder to create a snapshot of the administrative data files. You
can create the folder on another server.

Procedure
1. On the Avaya Contact Center Select server, click Start  > All Programs  > Avaya  >

Contact Center  > Manager Administration  > Configuration.

2. In the left pane of the Configuration window, expand Avaya > Applications.

3. In the Avaya Applications Configuration window, select Backup & Restore.

4. In the right-hand pane, click Backup & Restore.

Maintenance procedures
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5. In the Contact Center Manager Administration- Backup and Restore utility, select the
Backup tab.

6. Select the Drive or specify a Network Location where you want to store the backup.

7. Click Next.

8. On the Schedule page, select the frequency and start time for the backup schedule, or select
Run Now for immediate backups.

9. Click Next.

10. On the User Account with Administrative Privileges page, type a valid administrator user
name and password for the server on which you want to store the backup.

Note:

The default option is this computer. Avaya recommends that you store your backups in
a network location.

11. Click Finish.

12. Click Close.

All backups are saved as CCMADataBackup<BackupDateTime>.package.

Backing up the administration data
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Backing up the Contact Center databases
About this task
Perform an immediate backup of the Contact Center server databases to save the current data.
Perform a scheduled backup to maintain snapshots of data for emergency purposes. For more
information about scheduled backups, see Scheduling a backup of the Contact Center server
databases on page 96.

It is important to complete this procedure after you complete your installation or when any significant
change occurs in the database, so that you can restore the database easily if required.

Perform backups during low traffic volume periods.

Procedure
1. On the Contact Center server, choose Start > All Programs > Avaya > Contact Center >

Database Utilities > Database Maintenance.

2. In the Contact Center Database Maintenance window, in the Main Menu pane, click Backup
Locations.

3. In the right pane, click Create.

4. From the Drive Letter list, select the network drive on which to store the Contact Center
database.

5. In the UNC Path box, type the location to store the backup, in the format \\Computer Name
\Folder\Backup Location.

6. In the Username box, type the user name used to log on to the computer specified in the
UNC Path box. The user name is in the format Computer Name\Account Name.

7. In the Password box, type the user password.

8. Click OK.

9. In the Contact Center Database Maintenance window, in the Main Menu pane, click
Immediate Backup.

10. In the Media Type section, select Network Location.

11. From the Backup Location list, select the network drive on which to store the backup.

12. Click Backup.

13. Click Yes, to continue with the backup.

The database is backed-up.

14. Click Exit.

Maintenance procedures
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Creating a backup location for scheduled backups
Before you begin

• Ensure that you log on with a user account with full permissions to access the location where
you store the database backups.

About this task
Create a backup location on your network with the correct access permissions to ensure that you
have a designated location for the scheduled backups.

Procedure
1. Click Start  > All Programs  > Avaya  > Contact Center  > Database Utilities  > Database

Maintenance.

2. In the Database Maintenance dialog box, click Backup Locations.

3. In the right pane, click Create.

4. From the Drive Letter list, select a drive letter.

5. In the UNC Path text box, type the location to which to backup the database.

6. In the Username box, type the user name used to log on to the server specified in the UNC
Path box in the format Computer Name\Account Name.

7. In the Password box, type the Windows password.

8. Click OK.

Creating a backup location for scheduled backups
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Scheduling a backup of the Contact Center server
databases

Before you begin
• Create a backup location. For more information, see Creating a backup location for scheduled

backups on page 95.

About this task
Schedule a backup of the Contact Center server databases to save the data regularly. Perform a
scheduled backup to maintain snapshots of data for emergency purposes.

Perform backups during low traffic volume periods.

Maintenance procedures
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Procedure
1. Click Start  > All Programs  > Avaya  > Contact Center  > Database Utilities  > Database

Maintenance.

2. In the Database Maintenance dialog box, in the left pane, click Scheduled Backup.

3. In the right pane, click Create.

4. Under General Properties, in the Name box, type a name for the scheduled backup.

5. From the Media Type list, select Network Location.

6. In the Start Date box, type the date on which to begin scheduled backups.

OR

Click the calendar icon and select a date on which to begin scheduled backups.

7. In the Start Time box, select the time to start the backup.

8. From the Backup Location list, select a drive to store the backup.

9. From the Frequency list, select the frequency of the backup.

10. Click OK.

11. Click Exit to close the Database Maintenance utility.

Downloading the latest product documentation
About this task
Download the latest product documentation to ensure that you have the most recent updates.
Updates in the documentation accurately reflect the latest software changes.

Procedure
1. Log on to the Avaya Web site at http://support.avaya.com.

2. Compare the versions of the product documentation on the site with the versions you have.

3. If the version number on www.avaya.com is higher than the version number on the
documentation you have, download the latest version of the document.

4. Review the Avaya Web site for release notes and readme files.

Downloading the latest product documentation
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Verifying if installed patches are up-to-date
Before you begin

• Look up the latest patches and upgrades for your Contact Center server at http://
support.avaya.com.

About this task
Verify if installed patches are up-to-date by using the Contact Center Patch Viewer to view available
patches and to verify the patches that are already installed on the server. Use the Patch Viewer to
view the readme files associated with each patch.

Procedure
1. On the Contact Center server where you want to view available patches, click Start  > All

Programs  > Avaya  > Contact Center  > Common Utilities  > Contact Center Patch
Manager.

2. Compare the most recent update name in the Patch Manager with the latest patches listed
on the Avaya Web site.

Downloading the most recent Contact Center patches to
the server

Before you begin
• Ensure that you use an account with administrator privileges on your server.

About this task
Download the most recent Contact Center patches to the server from http://support.avaya.com to
ensure that you have the most current software.

Procedure
1. Log on to the server using an account with administrator privileges.

2. If a new service pack .msi file exists on http://support.avaya.com, download it and save it on
the Contact Center server.

Installing Contact Center patches
Before you begin

• Download the latest documentation. See Downloading the most recent product
documentation on page 97.

Maintenance procedures
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• Download the latest appropriate patches. See Downloading the most recent patches to the
server on page 98.

• Ensure that you use an account with administrator privileges on your server.

About this task
Install the latest Contact Center service pack or patches to ensure that you have the most current
development updates, or when you are upgrading your system.

The Contact Center Patch Viewer displays patches for installed Contact Center applications.

Procedure
1. Click Start  > All Programs  > Avaya  > Contact Center  > Common Utilities  > Contact

Center  > Contact Center Patch Manager.

2. Click Install.

3. Click Browse and navigate to the folder where you downloaded the service packs.

4. Click Scan for Updates.

The Contact Center Updates section displays the available service packs.

5. Select the appropriate service pack.

6. Click Install Update(s).

7. On the License Agreement window, read the End User License Agreement and if
acceptable, click I accept the terms in the license agreement.

8. Click Continue.

The Patch Manager installs the service pack and displays a confirmation message.

9. Click Close.

10. Verify that the newly installed service pack appears under Installed Updates.

Logging on to Avaya Media Server Element Manager
Before you begin

• Obtain a valid user name and password to access Avaya Media Server Element Manager.

About this task
Log on to the Avaya Media Server Element Manager as an administrator to configure Avaya Media
Server.

Element Manager (EM) is a web-based administration tool that facilitates the Operation,
Administration, and Maintenance (OAM) of Avaya Media Server. A SIP-enabled Contact Center
solution must contain one or more Avaya Media Server servers. Each Avaya Media Server server in
the Contact Center solution must be licensed and configured to provide media services.

Logging on to Avaya Media Server Element Manager
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Procedure
1. On a client computer, start a Web browser.

2. In the address box, enter https://SERVER_IP_ADDRESS:8443/em. Where
SERVER_IP_ADDRESS is the IP address of the Avaya Media Server.

3. In the User ID box, type the Avaya Media Server User ID log on account name. The default
Element Manager User ID account name is the Avaya MS server administrator account
name. If Avaya Media Server is installed on a Windows server, the default administrator
account name is Administrator. If Avaya Media Server is installed on a Linux server, the
default administrator account name is amsuser.

4. In the Password box, type the Avaya Media Server Element Manager password. The default
Element Manager password is the administrator password for the Avaya MS server.

5. Click Log in.

Creating a backup destination for Avaya Media Server
Before you begin

• Configure the destination ftp server and check that it is operational.
• Ensure that you have the address or host name, ftp account details, and path for the backup

server.

About this task
Create a location to store backups. You can specify an ftp server to which you can send backups
from Avaya Media Server Element Manager.

You can configure any number of remote backup destinations. When performing remote backups,
Element Manager (EM) uploads the backup files to the specified File Transfer Protocol (FTP) server
and then deletes the duplicate backup files from the Avaya Media Server server. To perform a
backup and restore, you must have permission to upload files to the remote backup destination.

You can accept the default backup location to save the Avaya Media Server backup on the local
server.

Procedure
1. Access the Element Manager with Administrator privileges.

2. Expand Tools.

3. Expand Backup and Restore.

4. Select Backup Destinations.

5. On the Backup Destinations page, click Add.

6. In the Destination Name field, type a unique name for the backup destination.

7. In the Host Name field, type the host name of the destination server.
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8. In the User Name field, type the ftp user name.

9. In the Password field, type the ftp password.

10. In the Destination Path field, type the path on the backup location to specify where the
backup function writes the backup files.

11. Optionally, select the Remove the local temporary file after transfer.

12. Optionally, click Test to test your connection.

13. Click Save.

Backing up the Avaya Media Server database
Before you begin

• Configure the destination ftp server and check that it is operational.
• Ensure that you have the address or host name, ftp account details, and path for the backup

server.

About this task
Create a location to store backups. You can specify an ftp server to which you can send Avaya
Media Server Element Manager backups. Backup the Avaya Media Server data so you can restore
it on the new server.

Procedure
1. Log on to the existing Avaya Media Server.

2. Access the Element Manager with administrator privileges.

3. Select Backup Tasks.

4. On the Backup Tasks window, click Add.

5. On the Add New Backup Task window, in the Backup Task Name box, type a name for this
backup.

6. Select System Configuration.

7. Select Application Content.

8. Choose the backup destination that you created for the migration.

9. Select Manually, as needed.

10. Click Save.

11. In the Backup Tasks window, select the backup task you created.

12. Click Run Now.

The Confirm Backup window appears, showing the backup task name details about the
backup.

Backing up the Avaya Media Server database
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13. Click Confirm.

The History Log Window appears. When the backup is complete, the backup details appear
in the list.

Backing up the Locale Specific Media Files on Windows
About this task
Backup the Avaya Media Server locale-specific media files so you can restore them. Locale-specific
files provide customized prompts and recorded announcements for your contact center
Orchestration Designer (OD) flow applications.

Important:
If you use more than one language in your Contact Center prompts and recorded
announcements, you must back up each language separately.

For example, you can use Play Prompt IVR blocks to choose the locale from which OD plays
prompts to callers. In a Canadian contact center, the flow applications can play either Canadian
English or Canadian French prompts depending on the caller's preference.

Procedure
1. Log on to the Avaya Media Server.

2. Navigate to the default location for the default locale-specific media files for your system.

For example, on Windows, the files are located in D:\Avaya\MAS
\Multimedia_Applications\MAS\platdata\Announcements\contactcenter
\default\xx\yy\l16 where xx is the country portion of the locale and yy is the language
portion of the locale

3. Create a .ZIP file of the contents of the folder, and save it with a meaningful name.

4. Copy the .ZIP file to a network location.

5. Repeat these steps for each locale and language from which your contact center uses media
files for prompts and announcements.

Installing Avaya Media Server patches on Windows
Before you begin

• Download and review the Contact Center Release Notes. The Release Notes contain the
known issues, patches, procedures, and workarounds specific to a release and patch line-up of
Contact Center. For more information about the Contact Center Release Notes, see 
www.avaya.com/support.

• Read the QFE Readme files for the most recent information and instructions.

Maintenance procedures
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• Download the most recent Avaya Media Server Quick Fix Engineering patches and store them
in the QFE subdirectory on the Avaya Media Server. QFE patches are ZIP files, do not un-zip
QFE patches. The Avaya Media Server patching utility uses the QFE ZIP files. For a Windows
server, the default QFE folder location is D:\Avaya\MAS\Multimedia_Applications\MAS\QFE.

• Backup the Avaya Media Server before applying patches.

About this task
You can patch Avaya Media Server using Avaya Media Server Quick Fix Engineering (QFE)
patches. Avaya Media Server QFE patches are not installed or maintained by the Contact Center
Patch Manager, they are independent of Contact Center. You must always install QFE patches
sequentially, as QFE patches are dependent on previous patches.

You must lock Avaya Media Server before applying patches and unlock it after you install the
patches. In a multiple node configuration, apply a patch one node at a time, allowing the calls to be
handled by other nodes in the Contact Center. Follow the procedure for each node.

Note:
Follow the instructions in the Contact Center Release Notes and in each Avaya Media Server
patch Readme file.

Procedure
1. Navigate to the Element Manager for the Avaya Media Server node you want to patch.

2. Select System Status > Monitoring > Active Sessions to check for active sessions on the
server.

3. If there are no active sessions, go to step 7.

4. In the navigation pane, click System Status  > Element Status.

5. From the More Actions list, select Pending Lock to lock the Avaya Media Server after all
processes finish.

6. Wait for existing active sessions to end.

7. In the More Actions menu, select Lock.

8. Click Stop and confirm the operation on the following page.

9. Close the Element Manager.

10. Open a command prompt window.

11. Obtain the correct name of the new QFE patch by entering the following command:

amspatch list all
The name of the file is not necessarily the same as the name of the patch name.

12. Under the QFE Name column, note the name of the patch (patchname).

13. Install all of the patches in numerical order. To install a new QFE patch on the system, enter
the following command:

amspatch apply <patchname>

Installing Avaya Media Server patches on Windows
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14. To install all downloaded QFE patches on the system, enter the following command:

amspatch apply all
15. When the patch application is complete, open the Element Manager navigation pane, and

click Tools > Software Inventory.

16. Verify the patch version listed in the Patch Level column is correct.

17. Select System Status > Element Status, and click Start. Confirm the operation.

18. From the More Actions list, select Unlock to unlock the Avaya Media Server.

19. Select System Status > Alarms and check for service-impacting alarms.

Starting or stopping Contact Center server services
Before you begin

• Ensure there are no active calls before stopping the Avaya Contact Center Select services.

About this task
Use the System Control and Monitor Utility to start or stop all Avaya Contact Center Select services.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. Click Start  > All Programs > Avaya > Contact Center > Common Utilities > System
Control and Monitor Utility.

3. Click the Contact Center tab.
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4. To start the Avaya Contact Center Select services, click Start Contact Center.

5. To stop the Avaya Contact Center Select services, click Shut down Contact Center.

Starting or stopping Contact Center server services
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Part 6: Customization

Chapter 10: Customizing the solution

This section describes how to customize the working contact center for your solution. The default
configuration is an example of a generic contact center solution. You can now customize Avaya
Contact Center Select to meet your requirements.

Avaya Contact Center Select provides sample data to minimize the time and effort needed to
validate basic contact center operation. You can also use the sample data provided as the initial
configuration for your solution. When you log on to Contact Center Manager Administration for the
first time, the following sample data is visible in the Management and Configuration components:

• Two sample supervisors, each created as a Supervisor/Agent. Contact Center creates a local
Windows user account on the server linked to each of these supervisor agents.

• Eight sample agents, each assigned to one of the two sample supervisor/agents. Contact
Center creates a local Windows user account on the server linked to each of these agents

• Two sample voice skillsets.

• One sample Agent Skillset Assignment and one sample Agent Supervisor Assignment.

• A sample skillset for each of the supported contact types. Each sample agent is assigned to
the voice skillset.

• Sample Activity codes, After Call Work Item codes, and Not Ready Reason codes.

• A sample CDN (Route Point) number for voice calls.

• A sample Open Queue Route Point for multimedia contacts.

• Two sample Multiplicity Presentation Classes. A Multiplicity Presentation Class enables an
agent to handle more than one contact type concurrently.

• One sample Route to provide music on a customer call.

• Three sample Threshold Classes with preconfigured values. Threshold classes determine how
statistics are presented on real-time and historical reports.

Avaya Contact Center Select Prompt Management allows the administrator to manage prompts on
the Avaya Media Server (Avaya MS). Contact Center provides a number of sample prompts and
sample music that you can use in your Orchestration Designer flow applications to treat Contact
Center calls. Contact Center also provides sample Orchestration Designer flow applications that use
the sample prompts and music provided, in addition to the standard Orchestration Designer flows
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available previously. All of the sample prompts have an associating variable that exists in
Orchestration Designer. This allows the administrator to modify the prompts within the flow
applications without opening Orchestration Designer.

Contact Center uses the sample CDN (Route Point) number to deliver calls to the sample
Customer_Service flow application. The Customer_Service flow application provides sample
treatments and routes the call to a sample agent.

The sample data provided allows you to make a first routed call in your contact center. It also serves
as your initial configuration and allows you to rapidly commission your Avaya Contact Center Select
solution.

Default user accounts
Account name Password Description
Administrator Administrator Default Contact Center Manager Administration administrator user.
reporting1 reporting1 A default Contact Center Manager Administration supervisor user.
reporting2 reporting2 A default Contact Center Manager Administration supervisor user.

Configuring Internet Explorer
About this task
Configure Internet Explorer to access Contact Center Manager Administration.

Install Microsoft Internet Explorer 8.0, 9.0, 10.0, or 11.0 (32 bit version only). Contact Center
Manager Administration supports only the 32 bit version of Microsoft Internet Explorer.

Note:
You must run Internet Explorer in compatibility mode for Contact Center Manager
Administration.

Procedure
1. Start Internet Explorer.

2. From the menu, select Tools > Internet Options.

3. In the Internet Options dialog box, click the Security tab.

4. Click the Trusted Sites icon.

5. Click Custom Level.

6. In the Security Settings dialog box for trusted sites, under the .NET Framework-reliant
components heading, select Enable for the following:

• Run components not signed with Authenticode

• Run components signed with Authenticode

Configuring Internet Explorer
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7. Under the ActiveX controls and plug-ins heading, select Enable for the following:

• Automatic prompting for ActiveX controls
• Download signed ActiveX controls
• Run ActiveX Controls and plug-ins
• Script ActiveX Controls marked safe for scripting

8. Under the Downloads heading, select Enable for the following:

• Automatic prompting for file downloads
• File download

9. Under the Miscellaneous heading, for Allow script-initiated windows without size or
position constraints, select Enable.

10. Under the Miscellaneous heading, for Allow websites to open windows without address
or status bars, select Enable.

11. Under Reset custom settings, from the Reset to: list select Medium-low.

12. Click Reset.

13. On the Warning dialog box, click Yes.

14. Click OK.

15. If you enabled ActiveX options, when a message appears asking you to confirm your choice,
click Yes.

16. Click the Trusted Sites icon.

17. Click Sites.

18. In the Trusted sites dialog box, clear the Require server verification {https:} for all sites
in this zone check box.

19. In the Add this Web site to the zone box, type the server name (not the IP address) for
your Avaya Contact Center Select server.

20. Click Add.

21. Click Close to return to the Internet Options dialog box.

22. Click the Privacy tab.

23. In the Pop-up Blocker section, select the Block pop-ups check box.

24. Click Settings.

25. In the Pop-up Blocker Settings dialog box, in the Address of website to allow box, type
the Avaya Contact Center Select server URL, http://<server name>/, where <server name>
is the name of the Avaya Contact Center Select server.

26. Click Add.

27. Click Close.

28. In the Internet Options dialog box, click the Advanced tab.
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29. Under Browsing, clear the Reuse windows for launching shortcuts check box.

30. Click OK to exit the Internet Options dialog box.

31. Restart Internet Explorer to activate your changes.

Starting the Script Variables tool in Contact Center
Manager Administration

Before you begin
• Ensure the client computer meets the administration client computer requirements. For more

information, see Avaya Contact Center Select Solution Description.
• Configure Internet Explorer. For more information, see Configuring Internet Explorer on

page 107.

About this task
Start the Script Variables tool to list the application variables on your system. You can also use this
window to create, update, or delete an application variable.

You can log on to CCMA for the first time as an administrator or a supervisor. For security reasons,
Avaya highly recommends that you change the default password when you first log on to the
application. CCMA user passwords can contain only English characters and special characters.

Procedure
1. Start Internet Explorer.

2. In the Address box, type the URL of the Avaya Contact Center Select server. The default
URL is http://<server name>, where <server name> is the host name of the Avaya
Contact Center Select server.

3. Press Enter.

4. In the main logon window, in the User ID box, type the user name. The default user ID is
Administrator.

5. In the Password box, type the password. The default user password is Administrator.

6. Click Log In.

7. From the Launchpad, select Scripting.

8. In the Scripting window, expand the system tree.

9. In the left pane, in the system tree, click your Contact Center Manager Server.

10. Click Script Variables.

Starting the Script Variables tool in Contact Center Manager Administration
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Checking variables for referencing applications
Before you begin

• Start the Script Variables tool. See Starting the Script Variables tool in CCMA on page 109.

About this task
Check a variable to see if it is referenced by an active application. If it is referenced by an active
application, you can change the value of the variable or the comment.

If you want to change the properties of a variable and how the variable appears in an application,
you can deactivate the application or remove the reference to the variable from the referencing
application.

Procedure
1. In the Scripting window, expand the system tree.

2. In the system tree, click CC.

3. Click Script Variables.

The system tree in the left pane expands to show all types of variables. The right pane
shows an alphabetical list of all variables. In the Script Variables grid, you can sort all
columns by clicking on the column header.

4. In the left pane of the Script Variables window, select the script variable that you want to
check.

5. In the right pane, click Script Variable Properties.

6. Under Referencing Scripts, determine which scripts use the variable.

7. View the Script Variable Properties to change the variable value or comment.

8. Click Submit.

Configuring business and public holiday dates
Before you begin

• Start the Contact Center Manager Administration Script Variables tool. See Starting the Script
Variables tool in CCMA on page 109.

• Ensure that the variable is not referenced by an active application. See Checking variables for
referencing applications on page 110.

About this task
Configure the dates on which the contact center is closed. For example, add the local business and
public holidays to the list of contact center holidays.

The Avaya Contact Center Select sample data includes a date variable “holidays_gv” with the
following values:

Customizing the solution
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Date value Holiday
01/01 New Year’s Day

Avaya recommends that you add your local business and public holidays and remove the sample
dates.

Procedure
1. From the Contact Center Manager Administration Launchpad, select Scripting.

2. In the Scripting window, expand the system tree.

3. In the system tree, click your Avaya Contact Center Select server.

4. Click Script Variables.

The system tree in the left pane expands to show all types of variables. The right pane
shows an alphabetical list of all variables. In the Script Variables grid, you can sort all
columns by clicking on the column header.

5. In the Script Variables window, select the script variable that you want to change. Expand
Date and select holidays_gv.

6. Click Script Variable Properties.

7. In the Script Variable Properties property sheet, select the Attribute tab.

Configuring business and public holiday dates
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8. In the List of Values table, add your local business and public holidays.

9. If any of the existing dates are not suitable for your solution, use the Remove button to
delete the dates.

10. Click any other row in the table to save the dates.

11. Click Submit.

Configuring the office hours
Before you begin

• Start the Contact Center Manager Administration Script Variables tool. See Starting the Script
Variables tool in CCMA on page 109.

• Ensure that the variable is not referenced by an active application. See Checking variables for
referencing applications on page 110.

About this task
Configure the time of day that your solution is open for business.

Customizing the solution
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Procedure
1. From the Contact Center Manager Administration Launchpad, select Scripting.

2. In the Scripting window, expand the system tree.

3. In the system tree, click your Avaya Contact Center Select server.

4. Click Script Variables.

The system tree in the left pane expands to show all types of variables. The right pane
shows an alphabetical list of all variables. In the Script Variables grid, you can sort all
columns by clicking on the column header.

5. In the Script Variables window, select the script variable that you want to change. Expand
TIME and select open_close_hours_gv.

6. Click Script Variable Properties.

7. In the Script Variable Properties property sheet, select the Attribute tab.

8. In the List of Values table, edit the time of day that your contact center opens. This is the
first time in the list. The default is 00:00.

9. In the List of Values table, edit the time of day your contact center closes. This is the
second time in the list. The default is 23:59.

Configuring the office hours
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10. Click Submit.

Changing the default voice mail number
Before you begin

• Start the Contact Center Manager Administration Script Variables tool. See Starting the Script
Variables tool in CCMA on page 109.

• Ensure that the variable is not referenced by an active application. See Checking variables for
referencing applications on page 110.

About this task
Change the default voice mail number to match your solution. This voice mail number is used by
“Option 4” in the Customer Service sample Orchestration Designer flow application.

Procedure
1. From the Contact Center Manager Administration Launchpad, select Scripting.

2. In the Scripting window, expand the system tree.

3. In the system tree, click your Avaya Contact Center Select server.

4. Click Script Variables.

The system tree in the left pane expands to show all types of variables. The right pane
shows an alphabetical list of all variables. In the Script Variables grid, you can sort all
columns by clicking on the column header.

5. In the Script Variables window, select the script variable that you want to change. Expand
DN and select Voicemail_gv.

6. Click Script Variable Properties.

7. In the Script Variable Properties property sheet, on the Attribute tab, change the Value
field as required. Enter the voice mail number for your solution. The default voice mail
number is 6999.

Customizing the solution
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8. Click Submit.

Changing the voice prompt audio files
Before you begin

• Record your own media files. Avaya Contact Center Select provides optimum playback
performance with .WAV files encoded as Linear 16-bit PCM, 8KHz Mono with a sampling rate
of 128kbits/sec.

• Copy the media files onto the Avaya Contact Center Select server.

About this task
Avaya Contact Center Select provides a number of default media files. You can replace these
default media files with your own recordings.

For example, to replace the Welcome_CS media file, record your own main welcome audio media
file, and add the media file to the Avaya Contact Center Select Content Group, giving it a Media
Name of Welcome_CS.

Changing the voice prompt audio files
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Procedure
1. Start Internet Explorer.

2. In the Address box, type the URL of the Avaya Contact Center Select server. The default
URL is http://<server name>, where <server name> is the computer name of the
Avaya Contact Center Select server.

3. Press Enter.

4. In the main logon window, in the User ID box, type the user name.

5. In the Password box, type the password.

6. Click Log In.

7. From the Launchpad, select Prompt Management.

8. In the Prompt Management window, in the left pane, expand the system tree.

9. In the left pane, expand the locale-specific Content Group for your solution. For example,
expand en_us.

10. In the right pane, select the audio media file to update. Note the Name of the media. For
example, note “Welcome_CS”.

11. Click Add Media.
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12. Click Select and browse to the location of your custom audio media file.

13. Click Open.

14. In the Media Name box, type the name of the existing media that you want to replace. For
example, type Welcome_CS.

15. Click Save.

16. On the message box, click OK to overwrite the existing media file.

Changing the voice prompt audio files
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Chapter 11: Avaya Contact Center Select
users

Avaya Contact Center Select includes two types of users in Contact Center Manager Administration
— an administrator user and a supervisor user. By default, Contact Center creates one
administrator user and two supervisor users. Contact Center assigns the appropriate access classes
and partitions to the created accounts.

A supervisor user can perform only a subset of the tasks an administrator can perform. This
includes, but is not limited to:

• assigning agents to skillsets

• changing an agent’s supervisor

• creating and editing activity codes

• viewing existing real-time reports

• making private copies of real-time reports

• launching Emergency Help

• running historical reports

• using the Audit Trail

The Launchpad options available to a supervisor user in Contact Center Manager Administration are
limited. The administrator can choose to edit the access classes and partitions assigned to a
supervisor user.

The administrator performs advanced configuration tasks in Contact Center Manager
Administration, in addition to the tasks listed above.

If you selected the Sample Agent Starting ID default configuration values when deploying Avaya
Contact Center Select, the following agents and supervisors are automatically created during the
installation.

User Type User name User ID Default password
Agent Supervisor sample1 supervisor 6001 Pw_6_001
Agent sample1 agent1 6002 Pw_6_002
Agent sample2 agent2 6003 Pw_6_003
Agent sample3 agent3 6004 Pw_6_004
Agent sample4 agent4 6005 Pw_6_005
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User Type User name User ID Default password
Agent sample5 agent5 6006 Pw_6_006
Agent Supervisor sample2 supervisor 6007 Pw_6_007
Agent sample8 agent8 6008 Pw_6_008
Agent sample9 agent9 6009 Pw_6_009
Agent sample10 agent10 6010 Pw_6_010

The Sample Agent Starting ID default value is 6001. The default Number of sample agents to create
is 10.

If you entered a different Sample Agent Starting ID when running the Avaya Contact Center Select
Ignition Wizard, the logon IDs and passwords entered here are not the default sample values. If you
use agent IDs that are different to the sample values, then the password format is
Pw_firstdigit_remainingdigits. For example, if you entered a Sample Agent Starting ID of 7701, then
your first supervisor “7701” has the password “Pw_7_701”. Agent “7702” has a password of
“Pw_7_702”.

Logging on to Contact Center Manager Administration
Before you begin

• Ensure the client computer meets the administration client computer requirements. For more
information, see Avaya Contact Center Select Solution Description.

• Configure Internet Explorer. For more information, see Configuring Internet Explorer on
page 107.

About this task
Log on to Contact Center Manager Administration (CCMA) to configure and administer your contact
center resources.

You can log on to CCMA for the first time as an administrator or a supervisor. For security reasons,
Avaya highly recommends that you change the default password when you first log on to the
application. CCMA user passwords can contain only English characters and special characters.

Procedure
1. Start Internet Explorer.

2. In the Address box, type the URL of the Avaya Contact Center Select server. The default
URL is http://<server name>, where <server name> is the host name of the Avaya
Contact Center Select server.

3. Press Enter.

4. In the main logon window, in the User ID box, type the user name. The default user ID is
Administrator.

5. In the Password box, type the password. The default user password is Administrator.

Logging on to Contact Center Manager Administration

December 2014 Deploying Avaya Contact Center Select DVD     119
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Contact Center Select DVD


6. Click Log In.

Creating a new agent
Before you begin

• Log on to Contact Center Manager Administration (CCMA).
• If you want to associate an agent with a domain account, you must first add the server to the

domain.

About this task
Complete this procedure to use Contact Center Manager Administration to ceate a new Avaya
Contact Center Select agent. Contact Center Manager Administration also uses the agent’s name
and password to create a local Windows account on the Avaya Contact Center Select server.

Procedure
1. On the Contact Center Manager Administration Launchpad, select Contact Center

Management.

2. In the left pane, click the Contact Center Manager Server under which to add the agent.

3. From the Add menu, select Agent.

4. In the New Agent Details window, enter the following mandatory information about the agent:

• First name
• Last name
• Login ID
• Primary supervisor
• Password
• Confirm Password

5. Enter any optional information about the agent (for example, Call Presentation Class,
Threshold, Title, Department, or Comments).

6. Under Windows User Account Details, select Workgroup or Domain. If your solution
implements the Business Continuity feature, the Domain option is available.

7. If you select Workgroup:

a. In the Password box, type the password for the new local Windows user account
associated with this agent.

b. In the Confirm Password box, retype the password.

8. If you select Domain:

In the User name box, type the name of the agent’s domain user account in the format
DomainName\UserAccountName. This domain account is associated with the agent.

Avaya Contact Center Select users
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Important:

You must ensure that you associate the agent with a correct and valid domain user
account.

9. If this agent uses the multiplicity feature on Agent Desktop, select a multiplicity presentation
class from the Multiplicity Presentation Class list.

If multiplicity is not enabled, the Multiplicity Presentation Class list does not appear.

10. Click the Contact Types heading.

11. Select the check box beside each Contact Type to assign that contact type to the agent.

12. Click the Skillsets heading.

13. Click Assign Skillsets.

14. Click List All to list all skillsets configured on the server.

15. From the Priority list for each skillset to assign to the agent, select the priority level or select
Standby to put the agent in standby mode for this skillset.

Priority levels range from 1 to 48, with 1 being the highest priority for the skillset.

16. Select the check boxes beside the partitions to which to add the new agent.

17. Click Submit to save your changes.

Agent variable definitions
Name Description
First Name The first name of the user. The first name is

mandatory for all users and can be a maximum of 30
characters long.

Last Name The last name of the user. The last name is
mandatory for all users and can be a maximum of 30
characters long.

Title The title for the user. The title is optional and can be
up to 40 characters long.

Department The user's department. The department is optional
and can be up to 40 characters long.

Language Select the language preference for the user.
Language selection is mandatory for all users.

Comment Comments you have about the user. Comments are
optional and can be up to 127 characters in length.

User Type Select the user type. This value is mandatory. Select
the agent user type.

Creating a new agent
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Name Description
Agents are users who are assigned skillsets and who
answer contacts in the Contact Center. All agents
must be assigned to a supervisor.

Login ID The number that the user enters to log on to the
phone. This value is mandatory for all users.

Windows User Account Details — Password
(Workgroup only)

Contact Center Manager Administration uses the
agent name and password to create a local Microsoft
Windows user account on the Avaya Contact Center
Select server. Enter a suitably complex password for
the agent’s Microsoft Windows user account.

Windows User Account Details — User name
(Domain only)

The existing domain user account to associate with
the agent, in the format DomainName
\UserAccountName.

The account details must be correct. Agents cannot
log on to Agent Desktop if you type the account
details incorrectly.

Primary Supervisor The agent's supervisor. You can choose from all
supervisors configured on the server to which you
are currently logged on.

Call Presentation The call presentation class to assign to this agent.
The call presentation class determines whether the
agent can take a break between calls, whether the
agent can put DN calls on hold for incoming ACD
calls, and whether the agent phone shows that the
agent is reserved for a network call.

Call Presentation is mandatory for all users with
agent and supervisor/agent capability.

Multiplicity Presentation Class The multiplicity presentation class to assign to this
agent. The multiplicity presentation class determines
the type and number of Multimedia contacts an
agent can have open simultaneously on Agent
Desktop.

If multiplicity is not enabled, the Multiplicity
Presentation Class list does not appear.

Threshold The threshold class to assign to this user.

The threshold class is mandatory for all users with
agent and supervisor/agent capability.

Avaya Contact Center Select users
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Updating agent details
Before you begin

• Log on to Contact Center Manager Administration (CCMA). For more information, see Logging
on to Contact Center Manager Administration on page 119.

About this task
Complete this procedure to edit the details of an agent or supervisor/agent.

Procedure
1. On the Contact Center Manager Administration Launchpad, select Contact Center

Management.

2. From the View/Edit menu, select Supervisors.

3. In the left pane, click the server on which to work with the supervisor/agent profile.

The list of supervisors configured on the server appears.

4. Click the supervisor to whom the agent is assigned.

The tree expands to show the list of agents assigned to this supervisor.

5. Right-click the agent whose profile you want to edit, and then select View Agent Details.

6. On the Supervisor/Agent Details window, in the User Details and Agent Information
sections, you can change agent details, such as first name, last name, user type, phone
login ID, primary supervisor, call presentation, threshold, title, department, or comments.

7. To change the current skillset assignment or assign the agent to new skillsets, click the
Skillsets heading.

The list of currently assigned skillsets appears.

8. To change the priority level for a skillset, in the table of assigned skillsets, from the Priority
list, select a new priority level.

9. To assign the agent to new skillsets, click List All to list all skillsets configured on the server.

10. In the table listing all skillsets, from the Priority list, select the priority level for each skillsets
to which you want to assign the agent.

OR

Select Standby to put the agent in standby mode for this skillset.

Skillset priority levels range from 1 to 48, with 1 being the highest priority for this skillset.

11. Select the check box for each partition to which you want to add the agent.

12. Click Submit to save your changes.

Updating agent details
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Copying agent properties
Before you begin

• Log on to Contact Center Manager Administration (CCMA). For more information, see Logging
on to Contact Center Manager Administration on page 119.

About this task
There are several ways to copy an agent's properties. This procedure lists one possible way. You
can also click Copy Agent Properties on the Functions menu in the Agents List window, or you can
right-click an agent name in the system tree, and then click Create Copy from the resulting pop-up
menu.

You can create new agents quickly by copying the properties of existing agents. New agents
assume the following properties from the existing agent:

• Skillset assignment
• Department
• User type
• Language
• Comment
• Supervisor
• Call presentation
• Threshold
• Contact type

When you copy an agent's properties, you must type in the new agent's name, login ID, and
password.

Procedure
1. On the Contact Center Manager Administration Launchpad, select Contact Center

Management.

2. From the View/Edit menu, select Supervisors.

3. In the left pane, click the server containing the agent to copy.

4. In the left pane, click the agent's supervisor.

The Supervisor window appears in the right pane, listing the assigned agents in a table.

5. In the table, click Functions beside the agent to copy, and then select Copy Agent
Properties.

The agent's properties appear in the New Agent Details window.

6. In the User Details section, type the new agent's name and phone login ID.

7. Optionally, can also change any of the copied properties. For example, you can assign the
agent to new skillsets or partitions in the appropriate areas of this window.

Avaya Contact Center Select users
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8. After you configure the new agent, click Submit to save the agent under the specified
supervisor.

The agent's icon appears in the system tree.

Copying agent properties
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Part 7: Agent Desktop

Chapter 12: Agent Desktop software
installation

This section describes how to install Agent Desktop software using the ClickOnce deployment
method or using a MSI file.

Avaya Contact Center Select agents can use the ClickOnce deployment method to download and
install Agent Desktop client software from the Avaya Contact Center Select server.

Avaya Contact Center Select administrators can use the MSI file deployment method to push Agent
Desktop software to agent client computers using a silent install.

If your solution uses the Avaya Contact Center Select Business Continuity feature, verify that the
solution is functional and resilient before installing Agent Desktop software on all of the client
computers.

Installing Agent Desktop software using ClickOnce
Before you begin

• Ensure the client computer meets the hardware and networking requirements for Agent
Desktop software. For more information about Agent Desktop requirements, see Avaya
Contact Center Select Solution Description.

• Ensure the client computer meets the Operating System requirements for Agent Desktop
software. For more information about Agent Desktop requirements, see Avaya Contact Center
Select Solution Description.

About this task
Install Agent Desktop software to handle Avaya Contact Center Select customer contacts.

Procedure
1. In Windows Explorer or Internet Explorer, type the HTTP address (URL) provided by your

system administrator.
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The URL format is:

http://<ContactCenterServerName>/agentdesktop
Where <ContactCenterServerName> is the Avaya Contact Center Select server name.

2. Click Install Prerequisites and follow the on screen instructions to install the .NET and
operating system components required to run Agent Desktop software.

3. Click Launch to download and install the most recent version of Agent Desktop software.

Agent Desktop client software silent installation
This section describes how to install the Agent Desktop client software silently, using a MSI file, on
each client computer in your contact center. Avaya Contact Center Select agents use Agent
Desktop software to handle customer voice and multimedia contacts.

Agent Desktop client software silent installation
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Installing software prerequisites for an Agent Desktop silent
install

Before you begin
• Download the most recent Service Pack and patches from the Avaya support Web site, http://

support.avaya.com.

About this task
Install the software prerequisites for Agent Desktop, so that you can install Agent Desktop silently.

You can use the Windows Add\Remove programs utility to uninstall the Agent Desktop software
prerequisites.

Procedure
1. Log on to the Avaya Contact Center Select server using administrator privileges.

2. Browse to <DRIVE>:\Avaya-ProductUpdates\Install Software\CCMM
\AvayaAura_CCMM_<XXX>\AAAD, where <DRIVE> is the drive on which you downloaded
the most recent Service Pack, and <XXX >is the version number of the latest Service Pack.

3. Copy the AAAD Prerequisites folder to a location from which you can copy it to the client
computer.

For example, copy the AAAD Prerequisites folder to a USB memory stick.

4. Log on to the client computer using administrator privileges.

5. Copy the AAAD Prerequisites folder to the client computer.

6. Install Microsoft Dot Net Framework 4.0.

7. Install Microsoft Visual C++ 2005 SP1 Redistributable Package x86.

8. Install Microsoft Visual C++ 2008 SP1 Redistributable Package x86.

Installing Agent Desktop client software silently
Before you begin

• Download the most recent Service Pack and patches from the Avaya support Web site.

About this task
Install Agent Desktop client software silently to install the software as a desktop application with an
All Users profile. This allows all agents that can log on to the client computer to run Agent Desktop
software. By default, the Agent Desktop software installs in the Program Files folder.

You can use the Windows Add\Remove programs utility to uninstall the Agent Desktop software.

Agent Desktop software installation
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Procedure
1. Log on to the Avaya Contact Center Select server using administrator privileges.

2. Browse to <DRIVE>:\Avaya-ProductUpdates\Install Software\CCMM
\AvayaAura_CCMM_<XXX>\, where <DRIVE> is the drive on which you downloaded the
most recent Service Pack, and <XXX >is the version number of the Service Pack.

3. Copy the AvayaAuraAgentDesktopClient.msi installation file.

4. Log on to the client computer using administrator privileges.

5. Copy the AvayaAuraAgentDesktopClient.msi installation file to the client computer.

6. Open a command prompt by clicking Start > All Programs > Run. Type cmd and press
Enter.

7. Use the Microsoft Windows Installer program (msiexec.exe) to install the software. For
example:

C:\AAAD>msiexec.exe /package AvayaAuraAgentDesktopClient.msi /
quiet /log "products.log”  MMSERVERNAME=MyCCMMServer
AAADUSEHTTPS=FALSE
Where:

• MMSERVERNAME — This parameter configures the name of the Avaya Contact Center
Select server that the Agent Desktop application communicates with. This parameter can
be an IP Address or a server name.    

• AAADUSEHTTPS — This binary parameter (TRUE or FALSE) configures Agent Desktop
to communicate with the Avaya Contact Center Select server using Hypertext Transfer
Protocol Secure (HTTPS). The default value is FALSE, do not use HTTPS.       

The Agent Desktop software installs silently.

8. Close the command prompt window.

Agent Desktop client software silent installation
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Part 8: Reporting

Chapter 13: Real Time Reporting

The Contact Center Manager Administration (CCMA) Real-Time Reporting displays provide up-to-
date statistics for your contact center and resources. With access to statistics that update in real-
time, such as the number of contacts waiting to be answered, the number of agents assigned to
each skillset, and the number of abandoned calls, you can view changes in contact activity as they
occur.

Real-time data is presented in the best format to help you react immediately to changing
circumstances, adjust skillsets and staffing levels, or reroute calls to other resources. Real-Time
Reporting displays make it easy to monitor peak periods and then adjust staffing levels as
appropriate - all to maintain the highest levels of customer service.

Using the Contact Center Status real-time display
About this task
Use the Avaya Contact Center Select Real-Time Reporting displays to monitor the performance of
the contact center in near real-time.

Avaya Contact Center Select offers a number of default public real-time displays. Create a private
copy of these displays and experiment with them to create displays that meet the day-to-day
requirements of your business.

For example, the CC Status public graphical display has the following panels:

Panel Type Description
CC_Standard_Agent_Display (CC) Tabular This tabular panel displays the agent status

and time in current state. Use this panel to
monitor individual agent activity.

CC_Contacts_Wait Chart This pie chart displays the number of
contact waiting for each skillset.

CC_Standard_Application_Display Tabular This tabular panel displays the maximum
wait times, and the number of contacts
offered, waiting, answered, or abandoned.
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Panel Type Description
CC_Sample_Skills Chart This panel displays the service level for

each skillset.

This combined display provides a real-time status report about important Avaya Contact Center
Select performance parameters.

Procedure
1. Start Internet Explorer.

2. In the Address box, type the URL of the Avaya Contact Center Select server. The default
URL is http://<server name>, where <server name> is the computer name of the
Avaya Contact Center Select server.

3. Press Enter.

4. In the main logon window, in the User ID box, type the user name. The default user ID is
Administrator.

5. In the Password box, type the password. The default user password is Administrator.

6. Click Log In.

7. On the Contact Center Manager Administration Launchpad, click Real-Time Reporting.

8. In the left pane, select the Public Graphical Displays folder.

9. In the left pane, from the list of displays, select CC_Status.

10. On the Public Collection properties tab, select the default display options for CC Status.
These standard displays combine to form an effective Real-Time Reporting graphical
display.

11. On the Public Collection properties tab, click Launch.

The Contact Center Status real-time display appears. The values you see on your display
depend on the number of active agents and contacts in your solution.

Using the Contact Center Status real-time display
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12. Use the display to monitor contact center performance in near real-time. Use this information
to tune the contact center to changing circumstances, adjust skillsets and staffing levels, or
reroute calls to other resources.

13. For more information about creating a private and modifiable copy of this real-time display,
see Administering Avaya Contact Center Select.

14. Experiment with Real-Time Reporting to find, copy, or create a set of displays that meet the
day-to-day requirements of your solution.

Real Time Reporting
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Part 9: Troubleshooting

Chapter 14: Troubleshooting tips

This section describes how to troubleshoot Avaya Contact Center Select. To avoid the frustration of
troubleshooting; plan your solution in advance. You can troubleshoot problems better by planning
for events in advance and having up-to-date information if troubleshooting is required. For example,
ensure that you know the correct user accounts, passwords, solution resources, and network
details. Plan ahead and ensure that you are using the correct information to install and commission
the Avaya Contact Center Select solution.

The main stages of the troubleshooting process are:

1. Identify the problem. Describe the symptoms of the problem. Is the problem intermittent or
reproducible? Has the problem always existed, or was it introduced after a recent
configuration change?

2. Determine the cause of the problem. Determining the most likely cause is a process of
elimination - eliminating potential causes of a problem. The most likely cause of a problem is
misconfiguration. Begin your investigation by double-checking the solution configuration
data.

3. Solve the problem. Identify and test the solution to the problem. Intermittent problems require
additional and prolonged soak testing.

Begin your troubleshooting by double-checking the solution configuration details, and then verify
that the individual components are working. If you are not able to solve the problem, collect all the
relevant information and have it available before contacting Avaya Technical Support.

Misconfiguration
In an integrated Avaya Contact Center Select and IP Office solution, the most likely cause of a
malfunction is misconfiguration. Avaya Contact Center Select and IP Office must be configured
correctly to work with each other. An apparently minor configuration error can be time-consuming
and frustrating to resolve. When configuring a solution, plan ahead and proceed with care.

If you encounter an issue with your solution, begin your investigation by double-checking the
solution configuration, focusing your investigation on the points of integration between Avaya
Contact Center Select and IP Office. Look for mismatched configuration data between Avaya
Contact Center Select and IP Office. For example, if IP Office is configured to use CDN (Route
Point) 7000, when Avaya Contact Center Select is configured to use CDN (Route Point) 3000. Both
must be configured to use the same CDN (Route Point) number. Ensure Avaya Contact Center
Select and IP Office both use the same SIP domain name.
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Solution components
Ensure that the Avaya Contact Center Select server part of the solution is working as intended. Use
the procedures in this section to verify that the Avaya Contact Center Select components are
running:

• Ensure the Avaya Contact Center Select application services are running.
• Ensure Avaya Contact Center Select can communicate with IP Office.
• Ensure Avaya Contact Center Select is registered with IP Office.
• Ensure Avaya Contact Center Select is licensed.
• If your solution supports the email contact type, ensure Avaya Contact Center Select can

communicate with the email server and mailbox.
Verify that Avaya Contact Center Select is running. If a component is stopped, start it. If the licenses
are all used up, obtain more. If email is not working, double-check your email server and mailbox.

Troubleshooting more complex issues
If you are not able to solve the problem, collect all relevant information and have it available before
contacting Avaya Technical Support. For all errors, record the error messages, the system
configuration, and actions taken before and after the error occurred.

• Review the Avaya Contact Center Select trace log files to diagnose the cause of the errors.
• Review the Avaya Contact Center Select application event logs to diagnose the cause of the

errors.
Work with Avaya Technical Support to clearly identify the problem. The Avaya customer support
representative might require remote access to Avaya Contact Center Select to complete the
investigation.

Troubleshooting by symptom
The following table lists a number of Avaya Contact Center Select issues and suggests a fix for
each issue.

Symptom How to fix
Avaya Contact Center
Select services not started

• Use the System Control and Monitor Utility to start the services. Click Start
Contact Center.

• Verify that the most recent Avaya Contact Center Select patches are
installed. For more information, see Installing contact center patches on
page 98.

• Verify the Avaya Contact Center Select server settings are correct. From the
Start menu, choose All Programs > Avaya > Contact Center > Manager
Server > Server Configuration.

Agents cannot log on to
Agent Desktop

• Verify that you are using the correct user name and password. The default
domain name is the host name of the Avaya Contact Center Select server.

Troubleshooting tips
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Symptom How to fix
• Ensure that there is an available IP Office extension for each Avaya Contact

Center Select agent. Ensure the extension is of type H.323. For more
information, see Configuring the agent extensions on page 32.

• Verify that there are sufficient agent licenses available. For more information,
see Checking the Contact Center License Manager real time usage on
page 150.

No CTI call control. Agent
Desktop is not controlling
the agent desk phone.

• Verify that Avaya Contact Center Select is communicating with IP Office. For
more information, see Checking the Contact Center connection to IP
Office on page 149.

• Verify that Avaya Contact Center Select is registered with IP Office. For more
information, see Checking that the SIP User Extension Number is acquired
on IP Office on page 147.

CDN (Route Point) calls
not arriving at Avaya
Contact Center Select

• Verify the IP Office short code number matches the Avaya Contact Center
Select CDN (Route Point) number. For more information, see Configuring a
shortcode to Contact Center Route Points on page 26.

• Verify that there are no space characters in the IP Office short code.

• Verify the IP Office short code is configured under the solution node, and not
under the IP Office server node.

• Verify that the Avaya Contact Center Select CDN (Route Point) number is
acquired in Contact Center Manager Administration.

Avaya Contact Center
Select not registered in IP
Office.

• Verify that Avaya Contact Center Select is registered with IP Office as a SIP
extension. For more information, see Checking that the SIP User Extension
Number is acquired on IP Office on page 147.

• Verify that Avaya Contact Center Select is registered as a SIP extension,
ensure it is not registered as a H.323 extension.

IP Office calls are routing
to the Avaya Contact
Center Select CDN (Route
Point), but the customer
caller cannot hear the
welcome announcement.

• The IP Office SIP domain name does not match the Avaya Contact Center
Select SIP domain name. For more information, see Configuring the SIP
domain name on page 24.

• The Avaya Media Server locale setting does not match the Avaya Contact
Center Select server locale (country and language) setting.

The Contact Center
Manager Administration
Web interface menus are
not visible in the left pane

• Ensure Internet Explorer is using Compatibility mode.

• Ensure the Contact Center Manager Administration Web interface client
computer display has a resolution of at least 1024 x 768 pixels.

The Contact Center
Manager Administration
Web interface looks
distorted

• Ensure the Contact Center Manager Administration Web interface client
computer display has a resolution of at least 1024 x 768 pixels.

• Ensure Internet Explorer is using Compatibility mode.

• Temporarily disable the Internet Explorer pop-up blocker to allow Contact
Center Manager Administration Active X controls and libraries to install.

The Avaya Contact Center
Select users visible in
Contact Center Manager

• Verify the Contact Center Manager Administration synchronization account
details used by IP Office. For more information, see Configuring the
synchronization user account on page 21.

Troubleshooting by symptom
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Symptom How to fix
Administration are not
visible in IP Office.

• In Contact Center Manager Administration, on the IP Office server
configuration window, click Synchronize.

Starting the Contact Center Dashboard
About this task
You can use the Contact Center Dashboard to access Contact Center system tools and diagnose
system problems. The Contact Center Dashboard displays some Operating System and system
details such as CPU type, network details, and Operating System activation status.

The Contact Center Dashboard launches automatically the first time the Contact Center server
boots up. You can configure the Contact Center Dashboard to launch every time the server reboots
and starts up.

Procedure
1. On the Avaya Contact Center Select server, click Start  > All Programs > Avaya > Contact

Center > Contact Center Dashboard.

2. If the Contact Center Dashboard Welcome message box appears, click OK.
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3. After a few moments the Contact Center Dashboard appears. Select the Home tab.

4. Click Refresh All to refresh the Contact Center Dashboard status reports.

5. In the Avaya Contact Center Status section, click View Services to monitor the state of the
Contact Center Windows services.

6. In the Avaya IP Office Server Availability section, click SIP Gateway Monitor to determine
if Contact Center is communicating with IP Office.
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7. Select the Connectivity tab.

8. Select SIP Gateway Monitor to monitor the status of the SIP connection to IP Office.

9. Select Contact Center Multimedia Dashboard to monitor the multimedia mailbox status.

10. Select Contact Center Manager Administration to access Contact Center Manager
Administration to configure and manage Contact Center resources.

11. Select System Control and Monitoring Utility to monitor, stop, and start Contact Center
services.

12. Select Contact Center License Manager to monitor license status and add additional
licensed features.

13. Select Business Continuity Support to configure the Business Continuity feature.
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14. Select the Software tab.

15. Contact Center Version displays the version of the Contact Center software installed on the
server.

16. Avaya Media Server displays the version of Avaya Media Server software installed on the
server.

17. Contact Center Services for Avaya Media Server displays the version of Contact Center
Services for Avaya Media Server software installed on the server.

18. Ignition Status displays the Contact Center software installation status.

19. Avaya Contact Center Components displays the Contact Center software and patch line-
up installed on the server.

20. Third Party Software Information displays the versions of the third-party software
components used by Contact Center that are installed on the server.
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21. Select the System tab.

22. Machine Name displays the host name of the Contact Center server.

23. Windows Domain displays the name of the domain that the Contact Center server is in.

24. Operating System displays the Operating System version.

25. Windows Activation Status displays the Windows Operating System license and activation
status.

26. RAM displays the amount of RAM memory in the server.

27. CPU displays the type of CPU in the server.

28. Network displays the networking details of the server: IP address and MAC address.

29. Hard Disks displays the number, size, and drive letter of the hard disk volumes in the
server.
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30. Select the Troubleshooting tab.

31. Select System Errors to access Contact Center events in the Microsoft Windows Event
Viewer.

32. Select Contact Center Log Files to access Contact Center trace log files.

33. Select Server Configuration to configure Contact Center licensed features and IP Office
voice network settings.

34. Select Contact Center Documentation to access and download the most recent Contact
Center documentation from the Avaya support web site.

Verifying the Contact Center services are started
About this task
Verify that the Contact Center services are started. Use the System Control and Monitor Utility to
verify that all necessary Avaya Contact Center Select services are running.

Verifying the Contact Center services are started
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Procedure
1. Log on to the Avaya Contact Center Select server.

2. Click Start  > All Programs > Avaya > Contact Center > Common Utilities > System
Control and Monitor Utility.

3. Click the Contact Center tab.

4. Select the LM tab, and verify that the Contact Center License Manager service is running.
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5. Select the CCMS tab, and verify that the Contact Center Manager Server services are
running.
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6. Select the CCMA tab, and verify that the Contact Center Manager Administration services
are running.

Troubleshooting tips

144     Deploying Avaya Contact Center Select DVD December 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Contact Center Select DVD


7. Select the CCT tab, and verify that the Communication Control Toolkit services are running.
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8. Select the CCMM tab, and verify that the Contact Center Multimedia services are running.
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9. Click Start Contact Center to start any stopped services.

Checking that the SIP User Extension Number is acquired
on IP Office

Before you begin
• Know the IP Office Manager log on details.
• Know how to use IP Office Manager.

About this task
Check that the SIP User Extension Number is acquired on IP Office. Avaya Contact Center Select
uses this SIP User Extension Number to register with IP Office for CTI call control and SIP session
messaging.
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Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the IP Office server, select User.

3. Locate the SIP User Extension Number used to register Avaya Contact Center Select.

4. If Avaya Contact Center Select is registered with IP Office, the Device Type for the SIP User
is configured as Avaya Contact Center Select.

5. If Avaya Contact Center Select is not registered with IP Office, ensure the SIP User
Extension Number and password details in IP Office match the details entered when
installing Avaya Contact Center Select.
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Checking the Contact Center connection to IP Office
About this task
Check the CTI call control and SIP session management connection from Avaya Contact Center
Select (ACCS) to IP Office.

Procedure
1. On the Avaya Contact Center Select server, click Start  > All Programs > Avaya > Contact

Center > Manager Server > SGM Management Client.

2. In the New Connection window, click Connect.

3. Ensure the Voice Outbound Proxy State is CONNECTED.

4. Ensure the CTI Proxy State is CONNECTED.

5. If your solution is using IP Office Release 9.1 or later, log on to IP Office Web Manager and
locate the ACCS server in the Solution pane. If IP Office is communicating with ACCS, the
ACCS server is listed on the Solution pane.
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Checking the Contact Center License Manager real time
usage

About this task
Check the real time usage of your contact center licenses to determine whether the necessary
licenses for your Avaya Contact Center Select features are present.

Procedure
1. On the Start menu of your Avaya Contact Center Select server, choose All Program >

Avaya  > Contact Center > License Manager > Configuration.

2. In the Contact Center Licensing window, click the Real Time Usage tab.
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3. Ensure the license types necessary for your Avaya Contact Center Select features are
present.

Using the CCMM dashboard
About this task
Use the CCMM dashboard to verify that Avaya Contact Center Select is communicating with the
email server and is monitoring the recipient mailbox.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. Click Start > All Programs > Avaya > Contact Center > Multimedia Server > Multimedia
Dashboard.

3. Ensure Avaya Contact Center Select is communicating with the inbound email server.

4. Ensure Avaya Contact Center Select is monitoring the recipient mailbox.
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Troubleshooting Contact Recording
About this task
Avaya Contact Center Select (ACCS) supports IP Office Contact Recording. IP Office uses User
Rights to configure and restrict how the ACCS users access and use Contact Recording. User
Rights act as templates for users, locking selected user settings to the template value. Some
settings are grouped and are set and locked as a group.

The following table shows the default IP Office User Rights for Avaya Contact Center Select
(ACCS):

ACCS Resource IP Office User Rights
ACCS SIP User Extension Application
Agent ACCS Agent
Supervisor agent ACCS Supervisor

Verify that the IP Office User Rights for ACCS are configured correctly.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the Solution node, select User Rights.

3. In the middle pane, select Application.
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4. Ensure the Avaya Contact Center Select SIP User Extension is assigned to the Application
— User Rights.

5. In the middle pane, select ACCS Agent.
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6. Ensure the Avaya Contact Center Select agents are assigned to the ACCS Agent — User
Rights.

7. In the middle pane, select ACCS Supervisor.
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8. Ensure the Avaya Contact Center Select agents are assigned to the ACCS Supervisor —
User Rights.
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